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Preface
Use the Metadata Manager User Guide to learn how to browse and search metadata in the Metadata Manager 
warehouse, view and edit metadata, run data lineage analysis, share metadata, and run reports.

This guide is written for business analysts who use Metadata Manager for metadata management and 
analysis.

Informatica Resources
Informatica provides you with a range of product resources through the Informatica Network and other online 
portals. Use the resources to get the most from your Informatica products and solutions and to learn from 
other Informatica users and subject matter experts.

Informatica Network
The Informatica Network is the gateway to many resources, including the Informatica Knowledge Base and 
Informatica Global Customer Support. To enter the Informatica Network, visit 
https://network.informatica.com.

As an Informatica Network member, you have the following options:

• Search the Knowledge Base for product resources.

• View product availability information.

• Create and review your support cases.

• Find your local Informatica User Group Network and collaborate with your peers.

Informatica Knowledge Base
Use the Informatica Knowledge Base to find product resources such as how-to articles, best practices, video 
tutorials, and answers to frequently asked questions.

To search the Knowledge Base, visit https://search.informatica.com. If you have questions, comments, or 
ideas about the Knowledge Base, contact the Informatica Knowledge Base team at 
KB_Feedback@informatica.com.

Informatica Documentation
Use the Informatica Documentation Portal to explore an extensive library of documentation for current and 
recent product releases. To explore the Documentation Portal, visit https://docs.informatica.com.

8

https://network.informatica.com
http://search.informatica.com
mailto:KB_Feedback@informatica.com
https://docs.informatica.com


If you have questions, comments, or ideas about the product documentation, contact the Informatica 
Documentation team at infa_documentation@informatica.com.

Informatica Product Availability Matrices
Product Availability Matrices (PAMs) indicate the versions of the operating systems, databases, and types of 
data sources and targets that a product release supports. You can browse the Informatica PAMs at 
https://network.informatica.com/community/informatica-network/product-availability-matrices.

Informatica Velocity
Informatica Velocity is a collection of tips and best practices developed by Informatica Professional Services 
and based on real-world experiences from hundreds of data management projects. Informatica Velocity 
represents the collective knowledge of Informatica consultants who work with organizations around the 
world to plan, develop, deploy, and maintain successful data management solutions.

You can find Informatica Velocity resources at http://velocity.informatica.com. If you have questions, 
comments, or ideas about Informatica Velocity, contact Informatica Professional Services at 
ips@informatica.com.

Informatica Marketplace
The Informatica Marketplace is a forum where you can find solutions that extend and enhance your 
Informatica implementations. Leverage any of the hundreds of solutions from Informatica developers and 
partners on the Marketplace to improve your productivity and speed up time to implementation on your 
projects. You can find the Informatica Marketplace at https://marketplace.informatica.com.

Informatica Global Customer Support
You can contact a Global Support Center by telephone or through the Informatica Network.

To find your local Informatica Global Customer Support telephone number, visit the Informatica website at 
the following link: 
https://www.informatica.com/services-and-training/customer-success-services/contact-us.html.

To find online support resources on the Informatica Network, visit https://network.informatica.com and 
select the eSupport option.
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C h a p t e r  1

Using Metadata Manager
This chapter includes the following topics:

• Metadata Manager Overview, 10

• Metadata Manager Interface, 12

• Metadata Manager Browse Tab Tasks, 15

• Logging In to Metadata Manager, 16

• Changing a Password, 17

Metadata Manager Overview
Informatica Metadata Manager is a web-based metadata management tool that you can use to browse and 
analyze metadata from disparate metadata repositories. Metadata Manager helps you understand and 
manage how information and processes are derived. It also helps you understand the fundamental 
relationships between information and processes, and how they are used.

Metadata Manager contains models that define the classes, attributes, and relationships for different types 
of metadata sources. Metadata Manager packages models for many application, business glossary, business 
intelligence, data integration, data modeling, and relational metadata sources. You can create custom models 
for metadata source types for which Metadata Manager does not package a model.

You create resources based on the models. Each resource represents a particular metadata source. 
Metadata Manager uses PowerCenter® workflows to extract metadata from a metadata source and load it 
into a centralized metadata warehouse called the Metadata Manager warehouse. After you load the metadata 
for a resource into the Metadata Manager warehouse, you can use Metadata Manager to browse and analyze 
the metadata for the resource.

Use Metadata Manager to complete the following tasks:

Browse and search metadata.

Browse and search the Metadata Manager warehouse and run data lineage analysis for the metadata in 
the Metadata Manager warehouse.

Create and edit custom models and attributes.

Create custom models to define the classes, attributes, and relationships for metadata sources for 
which Metadata Manager does not package a model. You can also add custom attributes to a model.
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Create, edit, and load resources.

Create resources to represent the metadata from individual metadata sources. Each resource contains 
the properties required to connect to the metadata source, extract metadata from the source, and load 
the extracted metadata into the Metadata Manager warehouse.

You can monitor and schedule resource loads. You can also purge resource metadata from the 
Metadata Manager warehouse.

Manage user permissions.

Manage permissions on resources and metadata objects in the Metadata Manager warehouse.

Resource Types
You can use Metadata Manager to extract and analyze metadata for different types of resources.

The following table lists the resource types and the associated metadata source types for which you can 
extract and analyze metadata:

Metadata Source Type Resource Type

Application SAP R/3

Business Glossary Business Glossary

Business Intelligence Business Objects
Cognos
Microsoft Analysis and Reporting Services
Microstrategy
Oracle Business Intelligence Enterprise Edition (OBIEE)
Tableau

Custom Custom

Data Integration Informatica Platform
Microsoft SQL Server Integration Services
PowerCenter

Data Modeling Embarcadero ERStudio
ERwin
SAP PowerDesigner
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Metadata Source Type Resource Type

Database Management Cloudera Navigator
IBM DB2 for Linux, UNIX, and Windows
IBM DB2 for z/OS
IBM Informix
JDBC
Microsoft SQL Server
Netezza
Oracle
Sybase ASE
Teradata

Other (non-custom) business intelligence, data integration, 
data modeling, or database management metadata sources

Universal

Note: Starting with Metadata Manager version 10.2 HotFix 2, SAP Business Warehouse resource is 
deprecated and no longer available.

For more information about supported metadata source versions, see the PCAE Metadata Manager XConnect 
Support Product Availability Matrix on Informatica Network: 
https://network.informatica.com/community/informatica-network/product-availability-matrices/overview

Metadata Manager Interface
You can work with resources, models, and user permissions in different ways through the Metadata Manager 
tabs and menus. The tabs that you see when you log into Metadata Manager vary based on your user 
privileges.

The following table describes the tabs and the tasks that you can perform:

Tab Tasks

Browse - Browse metadata in the metadata catalog.
- View resource, metadata object, and business glossary details.
- Search metadata in the metadata catalog and business glossary.
- Use shortcuts and folders to organize metadata objects.
- Add information about metadata objects in the metadata catalog.
- View data lineage analysis for metadata objects and business terms.
- Send email and export metadata objects and data lineage analysis.
- View reports on the Metadata Manager repository.

Model - Create, edit, and delete custom models.
- Add custom attributes to packaged, universal, and custom models.
- Export and import custom models.
For more information about Model tab tasks, see the Metadata Manager Custom Metadata Integration 
Guide.

12       Chapter 1: Using Metadata Manager

https://network.informatica.com/community/informatica-network/product-availability-matrices/overview


Tab Tasks

Load - Create, edit, and delete resources.
- Load resource metadata into the Metadata Manager warehouse.
- Monitor, cancel, and resume resource loads.
- Create schedules and add schedules to resources.
- Create data lineage links between resources.
- Purge metadata from the Metadata Manager warehouse.
- Manage the search index.
For more information about Load tab tasks, see the Metadata Manager Administrator Guide.

Permissions Manage permissions on resources and metadata objects in the Metadata Manager warehouse. For 
more information about Permissions tab tasks, see the Metadata Manager Administrator Guide.

The following table describes the menus and the tasks that you can perform:

Menu Tasks

Manage Change your password and configure your browse and search preferences.

Help Access Metadata Manager online help, view version information, and export the service log.
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Browse Tab
The Browse tab contains views, menus, and panels that you use to work with objects in Metadata Manager.

The following image shows the Browse tab:

1. Catalog, Glossary, and Shortcuts views
2. Search section
3. Actions menus
4. Details panel

The Browse tab contains the following components:

Catalog view

View the resources and metadata objects in the metadata catalog.

Glossary view

View business glossaries, categories, and business terms.

Shortcuts view

Create and manage shortcuts, folders, and shared folders.

Search section

Search for objects in the metadata catalog, in business glossaries, or in folders in the Shortcuts view.

Actions menu

Perform different tasks on a selected object such as run data lineage analysis, edit, export, or email 
object properties, or set permissions for the object. The tasks that you can perform vary based on the 
object type.

Details panel

View details about objects in the Catalog, Glossary, or Shortcuts view. For catalog objects, you can view 
the object definition or audit trail in the Details panel.
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Note: If you change the default font size in Microsoft Internet Explorer, Metadata Manager does not refresh 
the application. You must refresh the browser after changing the font size.

Metadata Manager Browse Tab Tasks
Use the Browse tab to browse, search, organize, edit, analyze, and share metadata in the metadata catalog. 
You can also run reports on the metadata in the Metadata Manager repository.

Browse Metadata Objects
You can use Catalog and Glossary views to browse the resource metadata in the Metadata Manager 
warehouse. Select metadata objects and view the properties for the metadata objects in the Details panel.

Use the Details panel to view information about metadata objects, including metadata object properties, 
related catalog objects, comments, links, business terms, and impact summary.

Related Topics:
• “Viewing Metadata” on page 18

Browse Business Glossaries
To view a business glossary in Metadata Manager, use the Glossary view on the Browse tab. You can view 
details for categories and business terms.

You can also view reference tables, relate business terms to technical metadata, and launch the Analyst tool 
to view categories and business terms in the Analyst tool business glossary.

Related Topics:
• “Business Glossaries” on page 80

Search Metadata Objects
Search for metadata objects in the metadata catalog. Perform a keyword or advanced search. You can also 
save search queries. Perform a keyword search or launch a new tab in Metadata Manager to perform an 
advanced search.

Related Topics:
• “Searching Metadata” on page 30

Organize Metadata
Create shortcuts and folders to manage metadata objects in the metadata catalog. In Metadata Manager, 
shortcuts are pointers to metadata objects in the metadata catalog.

Use the Shortcuts view to create and manage shortcuts to objects in the catalog, create and manage folders 
to store shortcuts, share folders with other users, and manage saved searches.
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Related Topics:
• “Working with Shortcuts and Folders” on page 42

Edit Metadata Objects
You can add comments and links to metadata objects in the metadata catalog. You can also add comments 
to business glossary objects. You can create and delete relationships for custom metadata objects and for 
business terms.

To add comments and links, use the Details panel. To create relationships, use the Details panel or the Object 
Relationships Wizard.

Related Topics:
• “Editing Metadata” on page 48

Analyze Metadata
Perform data lineage analysis to analyze metadata. Metadata Manager can show data lineage for objects in 
the Metadata Manager warehouse. Data lineage describes the path through which data flows. You can 
analyze the flow of data and troubleshoot transformation errors in metadata sources. You can view object 
details and relationships between objects in the metadata catalog and business glossary.

You can run data lineage analysis on metadata objects in the metadata catalog and business terms in a 
business glossary. When you navigate the data lineage diagram, you can expand, collapse, and highlight 
objects, and open the lineage analysis in a new window.

Related Topics:
• “Working with Data Lineage” on page 56

Share Metadata
Send metadata objects in an email, export metadata objects, or export a data lineage diagram.

Related Topics:
• “Sharing Metadata” on page 70

Logging In to Metadata Manager
Log in to Metadata Manager through your web browser. The information that you enter to log in to Metadata 
Manager varies based on the domain security configuration. If you are already authenticated within the 
Informatica domain, Metadata Manager bypasses the login page.

1. Open the web browser. 

2. In the address field, enter the following URL for the Metadata Manager login page: 

http(s)://<host>:<port>/mm
In the URL, <host>:<port> represents the host name and port number of the machine that runs the 
Metadata Manager Service.
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If the node is configured for HTTPS with a keystore that uses a self-signed certificate, a warning 
message appears. To enter the site, accept the certificate.

The login page appears.

3. Enter the login information. 

The information on the login page varies based on the domain security configuration. You might have to 
enter a user name, password, security domain, or namespace. If you do not know the security domain or 
the namespace that your user account belongs to, contact the Informatica domain administrator.

4. Click Login. 

The first time that you log in with the user name and password provided by the Informatica domain 
administrator, change your password to maintain security.

Cookies
If the domain does not use Kerberos authentication, the Informatica Service Manager creates a cookie that it 
uses to authenticate your user name in Metadata Manager. The Service Manager creates the cookie when 
you log in to Metadata Manager.

If you access Metadata Manager again before the cookie expires, the Service Manager uses the 
authentication information in the cookie to log you in to Metadata Manager. You must have cookies enabled 
in your browser for the Service Manager to create the cookie.

If the browser session is inactive for 12 hours or you log out of Metadata Manager, the Service Manager 
deletes the cookie. You can change the timeout for the cookie. To change the timeout value, update the 
Session.timeOut property in the Metadata Manager imm.properties file.

Changing a Password
Change a password through the Manage menu.

1. Click Manage > Account Settings. 

The Account Settings window appears.

2. Enter the old password. 

Passwords can be up to 80 characters.

3. Enter a new password and confirm the new password. 

4. Click OK. 

Changing a Password       17



C h a p t e r  2

Viewing Metadata
This chapter includes the following topics:

• Viewing Metadata Overview, 18

• Metadata Catalog, 19

• Metadata Details, 23

Viewing Metadata Overview
View metadata details on the Browse tab. You can view details about resources, metadata objects, business 
glossaries, and business glossary objects. You can also view audit trail information.

View metadata details through the following views on the Browse tab:

Catalog view

Use the Catalog view to view resources and the metadata objects within each resource. The Catalog 
view is also called the metadata catalog. You can use the List view to drill-down on individual objects or 
the Tree view to view metadata objects in a hierarchy. When you select a resource or metadata object, 
Metadata Manager displays the object details in the Details panel.

Glossary view

Use the Glossary view to view business glossary resources and the categories and terms within each 
glossary. You can use the Alphabet view to select individual categories and terms from an alphabetized 
list . You can use the Categories view to view categories and terms in a hierarchy. When you select a 
category or term, Metadata Manager displays details about the selected object in the Details panel.

You can also view metadata details from a data lineage diagram. When you select a metadata object, 
Metadata Manager displays the object details in the Details panel.

You can view the following metadata details:

Object definitions

When you select an object in the Catalog view, Glossary view, or data lineage diagram, Metadata 
Manager displays the object definition in the Details panel. The object definition includes the object 
properties, related business terms, links, comments, and related catalog objects. Some objects also 
display an impact summary. For business terms, the object definition also includes the categories to 
which the term belongs and the reference tables to which the term is linked.

Audit trails

To track the changes made to a metadata object, view the audit trail. For objects in packaged or 
universal resources, the audit trail displays the history of changes to business names and custom 
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attributes. For objects in custom resources, the audit trail displays the history of changes for all 
attributes. You can view audit trail information from the Catalog view or the data lineage diagram.

Metadata Catalog
Use the metadata catalog to view details about resources and metadata objects. You can navigate the 
metadata catalog through the List view or Tree view. You can also configure preferences for the metadata 
catalog.

Use the metadata catalog to browse the metadata in the Metadata Manager warehouse. Select a metadata 
object to display details about the object in the Details panel.

The metadata catalog displays the following types of objects:

Resources

Resources represent metadata sources in Metadata Manager. All metadata extracted from a metadata 
source and loaded into the Metadata Manager warehouse appears under the resource in the metadata 
catalog. All packaged, universal, and custom resources appear in the metadata catalog.

Logical groups

In the metadata catalog, Metadata Manager organizes objects of the same metadata type in logical 
groups. For example, Metadata Manager groups all tables in an Oracle schema in the Tables group. 
Logical groups can appear at multiple levels of the hierarchy, based on the structure of the model for the 
resource.

Metadata Manager displays fewer details for logical groups than it displays for resources or metadata 
objects. For logical groups, Metadata Manager displays only the group name and location.

Metadata objects

Metadata objects represent the data structures and fields in a metadata source. Metadata Manager uses 
the model for the resource type to extract metadata objects from the metadata source.

Navigate the metadata catalog to select an object. You can use the List view to drill-down through individual 
resources, logical groups, and metadata objects. Alternatively, you can use the Tree view to select resources, 
logical groups, or metadata objects from a hierarchy. By default, Metadata Manager displays 100 child 
objects for a parent object. You can configure the number of child objects displayed for any parent object in 
the Administrator tool.

You can configure preferences for the metadata catalog. Configure preferences to select the resource and 
metadata object types that you want to display in the metadata catalog.
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List View
Use the List view in the metadata catalog to drill-down through resources, logical groups, and metadata 
objects individually.

The following image shows the List view:

1. List view button
2. Sort button
3. Selected object path
4. Filter field
5. Objects list
6. Details panel

By default, Metadata Manager displays a list of all resources that are loaded in the Metadata Manager 
warehouse when you open the metadata catalog. To select a metadata object, select the resource that 
contains the object, drill-down through the metadata objects and logical groups, and click the object name.

Each time you click an object name, Metadata Manager displays the child objects in the objects list. You can 
sort and filter the objects list. Metadata Manager displays the metadata details for the selected object in the 
Details panel.

For example, to select an Oracle table, click the Oracle resource name, the schema name, the Tables logical 
group, and then the table name. When you click the table name, Metadata Manager displays the child logical 
groups for the table in the objects list. It displays the metadata details for the table in the Details panel.

Metadata Manager displays the selected object path above the list of objects. To navigate back up through 
the hierarchy of objects, click the link for the object you want to select.

For example, you view metadata details for PowerCenter mapping m_cdip_sapbw_aggs_extract_DH in the 
following object path:

MM/Auto_PC_90/MYLA/Mappings/m_cdip_sapbw_aggs_extract_DH

To select resource Auto_PC_90, click Auto_PC_90 in the object path. To navigate back to the resource list, 
click MM.
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Sorting and Filtering the List View
When you select an object in the List view, Metadata Manager displays the child objects in the objects list. By 
default, Metadata Manager lists the objects in ascending alphanumeric order. You can change the sort order 
and filter the objects list.

1. To sort the objects list, click the Sort button at the top of the objects list. 

To reverse the sort order, click the Sort button again.

2. To filter the objects list, enter the filter text in the field above the objects list, and click the Filter button. 

Metadata Manager lists the objects that contain the filter text.

For example, to list only objects that contain the string Ora, enter Ora in the filter field. You cannot use 
wildcard characters in the filter text.

To remove the filters, clear the filter field and click the Filter button.

Tree View
Use the Tree view in the metadata catalog to view resources, logical groups, and metadata objects in a 
hierarchy.

The following image shows the Tree view:

1. Tree view button
2. Hierarchy of metadata objects
3. Details panel

The Tree view in the metadata catalog displays objects in a hierarchy. To expand an object in the hierarchy 
and reveal the child objects, click the plus sign (+) next to the object name. To hide the child objects, click the 
minus sign (-). To select an object, click the object name. For faster navigation, Metadata Manager does not 
display the metadata details until you click the object name.

You can also expand objects and hide child objects by double-clicking an object name in the hierarchy. When 
you double-click an object, Metadata Manager selects the object and displays the metadata details in the 
Details panel.
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Recent History
Metadata Manager maintains a history of the objects that you view in the metadata catalog. Metadata 
Manager clears the recent history when you log out.

To view the history list, click View Recent History. Metadata Manager displays a list of the objects that you 
viewed during the current session. Click an object name to reopen the object.

To return to the List view or Tree view from the recent history, click Browse Catalog.

Catalog Preferences
You can customize the resources and metadata object types that appear in the metadata catalog.

Configure preferences to select resources in the Metadata Manager warehouse and the corresponding object 
types that you want to view. After you configure preferences, Metadata Manager updates the metadata 
catalog to reflect the changes.

The preferences that you configure for resources and object types also determine which resources and 
metadata objects that Metadata Manager exports when you export attributes to an Excel file. For more 
information about exporting attributes to an Excel file, see the Metadata Manager Custom Metadata 
Integration Guide.

Configuring Preferences for the Metadata Catalog
Use the Manage menu to configure preferences for the metadata catalog.

1. On the Browse tab, click Manage > Browse and Search Preferences. 

The Preferences window appears.

2. Click the Catalog & Business Glossary tab. 

3. Use the navigator to select the resources and object types that you want to display in the metadata 
catalog. 

4. Click OK. 

Metadata Catalog Tasks
Use the Actions menu to complete additional tasks on objects in the metadata catalog.

The following table describes the commands and the tasks that you can perform:

Command Task

Run Lineage View data lineage analysis on an object.

Export Lineage Export a lineage diagram to a Microsoft Excel file or a SVG file.

Add to Shortcuts Add a shortcut to a folder in the Shortcuts view for the object.

New > Custom 
Metadata

Create a custom resource or custom object in the metadata catalog.

Edit properties Edit properties for a custom metadata object or metadata object for which you added a 
custom attribute.
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Command Task

Delete Delete custom metadata objects.

Search Sets the search location as the current metadata object hierarchy. After you select this 
command, use the Search section to search for metadata objects in the currently selected 
hierarchy in the data lineage diagram.

Refresh Refreshes the catalog so that you can view changes that other users make to the metadata 
in the Metadata Manager warehouse.

Add as a Dependency Add a metadata object as a dependency to another object.

Set Permissions Configure permissions for metadata objects on the Permissions tab.

Import Metadata Import metadata from the following file types:
- XML. Import resources from an XML file.
- Excel. Import custom attributes and business name attributes for packaged and universal 

resources from an Excel file.

Export Metadata Export metadata to the following file types:
- XML. Export resources to an XML file.
- Excel. Export custom attributes and business name attributes for packaged and universal 

resources to an Excel file.

Email to Email information about a metadata object or a metadata object and its child objects. You 
can configure the information that you want to send.

Objects Relationship 
Wizard

Configure relationships with the Objects Relationship Wizard.

Related Topics:
• “Working with Shortcuts” on page 43

• “Relationships” on page 51

• “Working with Data Lineage” on page 56

• “Email” on page 72

• “Metadata Export” on page 74

Metadata Details
You can view metadata details for objects in the metadata catalog, for objects in data lineage diagrams, and 
for business glossary objects. Metadata Manager displays metadata details in the Details panel. Metadata 
details include object definitions and audit trail information.

Metadata Manager displays different details based on where you select a metadata object.

You can select a metadata object in the following places:

Metadata catalog

When you select an object in the Catalog view on the Browse tab, you can view the object definition and 
audit trail information.

Metadata Details       23



Use the Actions > View menu to switch among the different views. You can also use the Definition and 
Audit Trail buttons to switch between the object definition and audit trail information.

Data lineage diagram

When you select an object in a data lineage diagram, you can view the object definition and audit trail 
information.

Use the Definition and Audit Trail buttons to switch between the views.

Business glossary

When you select an object in the Glossary view on the Browse tab, you can view the object definition.

Object Definitions
You can view an object definition for any catalog or business glossary object. The object definition contains 
details about the metadata object.

Metadata Manager displays different details for different types of objects. For example, if you select a logical 
group in the metadata catalog, Metadata Manager displays the object properties. If you select a repository, 
Metadata Manager displays the object properties, related terms, links, comments, and related catalog 
objects.

The following table describes the details that Metadata Manager can display in the object definition:

Detail Description

Properties All properties for the object. If an object has a long list of properties, click More to expand the 
Properties list.
You can edit the following properties:
- Business name property for all metadata objects.
- All properties for custom metadata objects.
- Properties that you add to metadata objects for packaged and universal resources.
For more information about editing custom metadata object properties, see the Metadata 
Manager Custom Metadata Integration Guide.

Related Terms Business terms related to the current object.

Links Documents linked to the current object.

Comments Comments added to the object.

Related Catalog 
Objects

Metadata objects that are related to the selected object. Related catalog objects do not 
include parent or child objects. You can edit relationships for custom metadata objects and 
business terms.

Impact Summary - 
Downstream

Objects that the selected object impacts. In a data lineage diagram, these objects are 
downstream from the selected object.

Impact Summary - 
Upstream

Objects that the selected object is impacted by. In a data lineage diagram, these objects are 
upstream from the selected object.

Note: To see changes to the object definition that other Metadata Manager users have made, refresh the 
metadata catalog or business glossary.
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Related Topics:
• “Links” on page 49

• “Comments” on page 48

Viewing Object Definitions
View an object definition from the Catalog view or the Glossary view on the Browse tab. You can also view an 
object definition from the data lineage diagram. When you select an object, Metadata Manager displays the 
object definition by default.

If you are viewing audit trail information, perform either of the following tasks to display the object definition:

• If you are viewing audit trail information from the metadata catalog, click Actions > View > Definition, or 
click the Definition button.

• If you are viewing audit trail information from a data lineage diagram, click the Definition button.

Related Catalog Objects
When you view the details for a metadata object, the Related Catalog Objects section lists the metadata 
objects that have a direct association with the object that you are viewing.

An association represents the relationship between the objects. The relationship can be a data flow 
relationship or a non-data flow relationship.

A data flow relationship describes the movement of data between metadata objects. A direct data flow 
relationship means that data flows from one metadata object to another without passing through any other 
metadata objects. For example, a PowerCenter pass-through mapping reads data from a flat file source and 
loads it to a relational table. Within the mapping, data flows from the source definition instance to a Source 
Qualifier transformation instance and then to the target definition instance. There is a direct data flow 
relationship between the source definition instance and the Source Qualifier transformation instance. There 
is also a direct data flow relationship between the Source Qualifier transformation instance and the target 
definition instance.

A non-data flow relationship defines some other type of relationship between metadata objects. For example, 
a primary-key to foreign-key relationship between columns in different relational tables is a non-data flow 
relationship. The relationship between a PowerCenter mapping and the Session task instance that runs the 
mapping is also a non-data flow relationship.

When you view object details, the Related Catalog Objects section lists the metadata objects that have direct 
data flow and non-data flow relationships with the selected object. Metadata Manager does not list parent or 
child objects as related catalog objects.

Metadata Manager creates relationships between metadata objects in packaged or universal resources when 
you load metadata. You cannot edit these relationships.

You create relationships for custom and business glossary resources. For custom objects, you can use load 
templates, the Objects Relationship Wizard, or click Edit in the Related Catalog Objects section to create 
relationships. For business terms, you can use the Objects Relationship Wizard or you can click Edit in the 
Related Catalog Objects section to create relationships.

Related Topics:
• “Relationships” on page 51

• “ Relationships for Business Glossary Objects” on page 83
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Viewing Related Catalog Objects
View the related catalog objects for a metadata object or a business term on the Browse tab. You can sort 
and filter the related catalog objects by type, name, and path.

1. Open the Catalog view, Glossary view, or data lineage diagram. 

2. Select a metadata object or a business term. 

Metadata Manager displays the object details, including the related catalog objects, in the Details panel.

3. To sort the related catalog objects by type, name, or path, click the column heading. 

You can sort objects in ascending or descending alphanumeric order. Click the column heading again to 
change the sort order.

4. To filter the related catalog objects by type, name, or path, enter the filter text in the fields above the 
column headings, and click the Filter button. 

Metadata Manager lists the objects that contain the filter text.

For example, to display only objects in resource FinanceDB, enter MM/FinanceDB in the Path filter field. 
You cannot use wildcard characters in the filter text.

To remove the filters, clear the filter fields and click the Filter button.

Impact Summary
When you view the details of a metadata object in a packaged or universal resource, you can view an impact 
summary. The impact summary lists the high-level objects that impact and that are impacted by a metadata 
object.

For example, multiple reports in a business intelligence tool use a table in an Oracle database. A column is 
added to the table. You can view the impact summary of the Oracle table to find the list of business 
intelligence reports that might be impacted by this change.

Metadata Manager displays an impact summary for metadata objects that are directly involved in the data 
flow. You can view an impact summary for objects such as business intelligence reports and attributes, 
PowerCenter mappings and session task instances, data modeling entities and attributes, and relational 
tables and columns. Metadata Manager also displays an impact summary for business terms.

Metadata Manager does not display an impact summary for metadata objects that are not directly involved in 
the data flow. Therefore, Metadata Manager does not display an impact summary for objects such as 
business intelligence queries, PowerCenter workflows, data modeling diagrams, or relational indexes. 
Metadata Manager does not display an impact summary for metadata objects in custom resources.

When you view a metadata object in the metadata catalog, the impact summary lists the high-level objects 
that impact and are impacted by the object that you are viewing. High-level objects are the parent data 
structures of metadata objects that are directly involved in the data flow. High-level objects include objects 
such as reports, tables, PowerCenter mappings, and PowerCenter session task instances. The impact 
summary does not list lower-level objects that are involved in the data flow, such as columns, data attributes, 
and fields.

When you view a metadata object, the impact summary displays the following details:

Impact Summary - Downstream

Lists the high-level downstream objects. Changes to the selected metadata object impact these objects.

Impact Summary - Upstream

Lists the high-level upstream objects. Changes to these objects impact the selected metadata object.
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When you view a business term, the impact summary lists the high-level objects that impact and are 
impacted by the related catalog objects of the business term. For example, you relate business term "Sales 
Price" with Oracle column S_PRICE. When you view the business term, the impact summary lists the objects 
that impact and are impacted by Oracle column S_PRICE.

Note: Metadata Manager analyzes and finds impacted objects when you load resources. If a resource load 
fails, metadata objects in resources connected to the failed resource might have incorrect information in the 
impact summary. To view accurate information, verify that all of the connected resources are loaded 
successfully.

Impact Summary for PowerCenter Objects
When there is no direction of data flow between PowerCenter objects, Metadata Manager does not display 
the objects in the impact summary.

For example, a mapping has a direct association with the Session task instance that runs the mapping. 
However, there is no direction of data flow between these objects. Therefore, when you view metadata details 
for the Session task instance, Metadata Manager lists the mapping as a related catalog object. Metadata 
Manager does not list the mapping in the impact summary.

For PowerCenter objects, the following relationship types do not appear in the impact summary:

Session task instance and mapping

When you view metadata details for a Session task instance, Metadata Manager lists the mapping that 
the Session task instance runs as a related catalog object but not in the impact summary.

When you view metadata details for a mapping, Metadata Manager lists the Session task instance that 
runs the mapping as a related catalog object but not in the impact summary.

Mapping and mapplet instance

When you view metadata details for a mapping that contains a mapplet instance, Metadata Manager 
lists the mapplet instance as a related catalog object but not in the impact summary.

When you view metadata details for a mapplet instance that is part of a mapping, Metadata Manager 
lists the mapping as a related catalog object but not in the impact summary.

Differences between Impact Summary and Related Catalog Objects
When you view details for a metadata object in the metadata catalog, the impact summary and related 
catalog objects display different information.

The impact summary lists all high-level objects, such as tables and reports, that impact and are impacted by 
the metadata object that you are viewing. The impact summary does not list lower-level objects such as 
columns and data attributes. Objects in the impact summary have a data flow relationship with the object 
that you are viewing.

Related catalog objects have a direct association with the metadata object that you are viewing. The 
association can represent a data flow relationship between the objects or a non-data flow relationship such 
as a primary-key to foreign-key relationship between columns in relational tables. Related catalog objects can 
be high-level or lower-level objects.

For example, a PowerCenter resource contains mapping m_EmailPromo. The mapping reads from Oracle 
table CUST, filters the customer data, and writes the filtered data to flat file TargetedCustomers.csv. The 
mapping is used in PowerCenter session s_EmailPromo. Workflow wf_EmailPromo runs the session.

When you view mapping m_EmailPromo in the metadata catalog, you see the following metadata details:
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Related Catalog Objects

Lists PowerCenter Session task instance s_EmailPromo because there is a direct association between 
the mapping and the Session task instance.

The related catalog objects does not list Oracle table CUST or flat file TargetedCustomers.csv because 
they are related to objects within the mapping. Oracle table CUST is related to the source definition 
instance within the mapping. Similarly, flat file TargetedCustomers.csv it is related to the target 
definition instance within the mapping.

Impact Summary - Downstream

Lists flat file TargetedCustomers.csv because data flows from the mapping to this high-level object.

Impact Summary - Upstream

Lists Oracle table CUST because data flows from this high-level object into the mapping.

Viewing the Impact Summary
View the impact summary for a metadata object or a business term on the Browse tab. You can sort and filter 
the objects in the impact summary by type, name, and path.

1. Open the Catalog view, Glossary view, or data lineage diagram. 

2. Select a metadata object or a business term. 

Metadata Manager displays the object details in the Details panel.

3. To view the downstream impact summary, click Impact Summary - Downstream in the object details. 

4. To view the upstream impact summary, click Impact Summary - Upstream in the object details. 

5. To sort the objects in the impact summary by type, name, or path, click the column heading. 

You can sort objects in ascending or descending alphanumeric order. Click the column heading again to 
change the sort order.

6. To filter the objects in the impact summary by metadata source type, enable the Filter option and select 
the metadata source types. 

Click the open button next to the Filter option to select the metadata source types. You might have to 
scroll the browser window horizontally to see the open button.

7. To filter the objects in the impact summary by type, name, or path, enter the filter text in the fields above 
the column heading, and click the Filter button. 

Metadata Manager lists the objects that contain the filter text.

For example, to display only objects in Oracle resources, enter Ora or Oracle in the Type filter field. You 
cannot use wildcard characters in the filter text.

To remove the filters, clear the filter fields and click the Filter button.

Note: Displaying an impact summary that contains hundreds of objects can affect performance. Close the 
impact summary when you do not need to view the impact summary details.

Audit Trails
An audit trail displays the history of changes to a metadata object. For objects in packaged or universal 
resources, the audit trail displays the history of changes to business names and custom attributes. For 
objects in custom resources, the audit trail displays the history of changes for all attributes.

Changes made to a metadata object appear in the audit trail log. Use the audit trail to track the history of 
changes to a metadata object over time.
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The audit trail change log displays the previous value for an object property and the value to which it was 
changed. The audit trail also displays the user account that made the edit and the date on which the edit was 
made.

You can sort the audit trail information in ascending or descending order.

Viewing Audit Trails
View audit trail information for a metadata object on the Browse tab. You can sort and filter the audit trail 
information.

1. Open the Catalog view or data lineage diagram. 

2. Select the metadata object for which you want to view the audit trail. 

Metadata Manager displays the object details in the Details panel.

3. In the Details panel, click the Audit Trail button. 

Metadata Manager displays the audit trail information in the Details panel.

4. To sort the audit trail information by update date, user that changed the object, or change log, click the 
column heading. 

You can sort objects in ascending or descending alphanumeric order. Click the column heading again to 
change the sort order.

5. To filter audit trails by period, choose a period from the Period list and click Go. 

6. To filter audit trails by a specific property, choose a property from the Attribute list and click Go. 
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C h a p t e r  3

Searching Metadata
This chapter includes the following topics:

• Searching Metadata Overview, 30

• Search Location, 31

• Keyword Search, 32

• Advanced Search, 33

• Search Results, 35

• Understanding Searches and Search Syntax, 36

• Saved Searches, 39

• Troubleshooting Searches, 41

Searching Metadata Overview
When you search for objects in the Metadata Manager warehouse, you can perform a keyword search or an 
advanced search. Perform a search from menu bar on the Browse tab. Metadata Manager displays the 
search results in the Search Results panel.

By default, Metadata Manager searches for the following objects that match a keyword:

• Metadata objects in the metadata catalog

• Categories and business terms across business glossaries

• Shortcuts

• Folders

• Saved searches

You can configure the location and object properties that Metadata Manager searches.

You can perform the following tasks when you search metadata:

Configure the search location.

Select the location that Metadata Manager searches when you perform a keyword search or an 
advanced search. You can search all of the Browse tab, the Catalog view, the Glossary view, or the 
Shortcuts view. You can also click Browse to select a specific location to search such as a particular 
resource, business glossary, or shortcuts folder.
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Perform a keyword search.

To search all object properties that match a keyword, use a keyword search. Choose the search location, 
and enter the keyword to search for.

Perform an advanced search.

To limit the object properties and classes that Metadata Manager searches, perform an advanced 
search. Choose the search location, and select the object class, date modified or created, and object 
properties.

Configure preferences for search results.

Specify the object properties that Metadata Manager displays in the search results.

Save searches.

You can save an advanced search query. You can edit and run saved searches.

Related Topics:
• “Search Results” on page 35

• “Understanding Searches and Search Syntax” on page 36

• “Saved Searches” on page 39

• “Performing a Keyword Search” on page 32

• “Performing an Advanced Search” on page 34

Search Location
You configure the location that Metadata Manager searches when you perform a keyword search or an 
advanced search. By default, Metadata Manager searches in all locations.

To configure the search location, click the Search field and select the location that you want to search.

You can select the following search locations:

All

Search all objects in the Catalog, Glossary, and Shortcuts views.

Shortcuts

Search shortcuts, folders, and saved search queries.

Catalog

Search all metadata objects in the metadata catalog.

Glossary

Search all categories and business terms in a business glossary.

Browse

Search a specific hierarchy in the metadata catalog or business glossary, or search a specific folder in 
the Shortcuts view.
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Keyword Search
Perform a keyword search to search all properties of objects that match the keyword. Metadata Manager 
searches for objects with properties that match the search criteria.

You can use search operators and wildcard characters in a keyword search. For more complex search 
queries, perform an advanced search.

Performing a Keyword Search
To perform a keyword search, select the search location and enter the search keyword.

1. On the menu bar of the Browse tab, select the search location from the Search list. 

2. Select the search location: 

• To search the metadata catalog, all business glossaries, or all shortcuts, select Catalog, Glossary, or 
Shortcuts, respectively.

• To search a hierarchy in the metadata catalog, a business glossary, or shortcuts, click Browse, select 
the top-level object in the hierarchy, and click OK.

3. Enter the search keyword. 

4. Click Go. 

Metadata Manager displays the results of the search in the Search Results panel.

Related Topics:
• “Search Results” on page 35

• “Understanding Searches and Search Syntax” on page 36

Understanding Keyword Search Results
When you enter a keyword, Metadata Manager returns objects with properties that start with the keyword. 
Metadata Manager also returns objects that include the keyword when a space precedes the keyword.

For example, you use the keyword “res” to search for object names in a catalog with the following objects:

Resource Management
Restore_CT
Object_resources
Object Restore
Dress Mart

The search returns the following results:

Resource Management
Restore_CT
Object Restore
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Advanced Search
Perform an advanced search to limit the object properties and object types that Metadata Manager searches. 
You can specify multiple search conditions. Metadata Manager searches for objects with properties that 
match the search criteria.

The following table describes the search properties that you can configure to perform an advanced search:

Property Description

Location Location of the objects you want to search. Select one of the following options:
- All
- Shortcuts
- Catalog
- Glossary
- Browse. Allows you to select a specific metadata object, business glossary object, or folder to 

search.
Default is All.

Object type Object type that you want to search for. Metadata Manager includes all object types for all metadata 
sources you can load into the Metadata Manager warehouse. The object types available are based on 
the location you choose to search.
Use AND or OR to search for multiple object properties or multiple object types.

Include 
audit trail

Includes the historical values of object properties in the search.

Date Date the metadata object was created or last modified. Select Created or Last Modified and one of the 
following options:
- Anytime. Search for all objects.
- Within the last. Search for objects created or modified within a specific number of days, weeks, or 

months.
- Since. Search for objects created or modified after a specific date. Use the calendar to select the 

date.
- Between. Search for objects created or modified between two dates. Use the calendar to select the 

dates.
Default values are Last Modified and Anytime.

Property Object property to search for. Select Any Property to search all metadata object properties or select 
Other to choose the property. The properties available depend on the object types you choose.
Select Other to search for a business name property.
Use AND or OR to search for multiple object properties or multiple object types.
Note: You cannot search for metadata extensions that are defined for PowerCenter metadata objects.

Condition Condition for the property. Select one of the following options:
- is. Property matches the search keyword.
- starts with. Property starts with the search keyword.
- contains any of the following. Property contains any of the search keywords.
- is any of the following. Property matches one of the search keywords.
- starts with any of the following. Property starts with one of the keywords.

Search 
keyword

Keyword to search for. To search for multiple keywords, enter the keywords separated by spaces. You 
can use wildcards and additional search conditions.
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Metadata Object Properties
When you perform an advanced search, you can configure the object properties that you want to search for. 
Metadata Manager displays a complete list of properties when you configure an advanced search.

The following table describes the common object properties that you can select for an advanced search:

Property Description

Any Property Any of the matching properties associated with the object.

Annotations Comments added to the metadata object.

Description Descriptive information about the metadata object.

Name Name of the metadata object as it appears in the metadata source or the business glossary.

Other Other properties associated with the object. Opens a window from which you can select the property.

Performing an Advanced Search
To perform an advanced search, select the search location, enter the search keyword, and select the object 
properties to search for.

1. On the menu bar of the Browse tab, select Advanced Search in the Search list. 

The Advanced Search panel appears.

2. Select the search location: 

• To search all locations, all shortcuts, the metadata catalog, or all business glossaries, select All, 
Shortcuts, Catalog, or Glossary, respectively.

• To search a hierarchy in the metadata catalog, a business glossary, or shortcuts, click Browse, select 
the top-level object in the hierarchy, and click OK.

3. Configure the search properties and enter the keyword. 

4. Optionally, include audit trail information in the search. 

5. To add search conditions, click AND or OR and configure the search conditions. 

6. Click Go. 

Metadata Manager displays the results of the search in the Search Results panel.

7. To clear the search properties, click Clear. 

8. To save the search, click the Save button. 

Related Topics:
• “Saving Searches” on page 40

• “Understanding Searches and Search Syntax” on page 36
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Search Results
Metadata Manager displays the results of a search and the number of objects found in the Search Results 
panel. Click an object name to view the object in the metadata catalog or business glossary. You can resize, 
minimize, and restore the Search Results panel.

Metadata Manager displays search results based on the priority assigned in the searchpriorities.xml file. 
Administrators can use this file to configure the priorities of saved searches and other entities in the search 
results. For more information about the searchpriorities.xml file, see the Metadata Manager Administrator 
Guide.

Metadata Manager displays the object name, class, and location for objects that appears in the search 
results. If you searched the audit trail, Metadata Manager appends "audit trail" to the names of objects that 
have historical attribute values that match the search criteria. Click an object name to view it in the metadata 
catalog or business glossary. You can also right-click an object in the search results to complete additional 
tasks on the object.

The following table describes the commands and the tasks that you can perform on metadata and business 
glossary objects:

Command Task

Run Lineage View data lineage analysis on an object.

Show in Catalog
Show in Glossary

Find a metadata object in the metadata catalog hierarchy or find a category or business term in 
the business glossary. Use this option to avoid browsing for a particular object in the catalog or 
business glossary.

Add to Shortcuts Add a shortcut to a folder in the Shortcuts view for the object.

Edit properties Edit properties for a custom metadata object or metadata object for which you added a custom 
attribute.

Delete Delete custom metadata objects.

Note: Metadata Manager displays an error if a search query returns more than 1,024 results. Use more 
specific search criteria to limit the number of search results returned.

Related Topics:
• “Metadata Catalog” on page 19

• “Working with Shortcuts” on page 43

• “Editing Metadata” on page 48

• “Working with Data Lineage” on page 56

Configuring Preferences for Search Results
Use the Manage menu to configure preferences for search results. You can configure the properties that 
Metadata Manager displays for objects in the search results.

1. On the Browse tab, click Manage > Browse and Search Preferences. 

The Preferences window appears.

2. Click the Search tab. 
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3. In the Available Fields list, select the object properties that you want to appear in search results, and 
move the properties to the Visible Fields list. 

To reorder the properties, use the up and down arrows.

4. Click OK. 

Understanding Searches and Search Syntax
When you perform a search, Metadata Manager searches index files created based on the metadata in the 
Metadata Manager warehouse. Metadata Manager uses a search analyzer to create index files and perform 
searches. This analyzer is used to index and search in English.

Note: Unless otherwise specified, the information in this manual applies to the default analyzer.

Special Characters and Common Words
Metadata Manager ignores special characters and common words when it indexes metadata.

For example, when Metadata Manager indexes the object name Products-Sales_Data, it ignores the dash as a 
special character, resulting in the term Products Sales_Data.

To use special characters in a search, use a backslash (\) before the special character. For example, to 
search for Products-Sales_Data, use the following syntax:

Products\-Sales_Data
Because Metadata Manager indexes a special character as a space, Metadata Manager returns objects with 
any special character in the same location. For example, if you search for Products\-Sales_Data, Metadata 
Manager returns any of the following objects:

Products-Sales_Data
Products:Sales_Data
Products!Sales_Data

Metadata Manager does not index the following special characters:

~, !, ^, &&, *, ( ), -, +, { }, [ ], ||, \, :, ", ?, any single alphabetic character a-z or A-Z

By default, Metadata Manager does not index the following common words:

a
an
and
are
as
at
be
but
by
for
if
in
into
is
it
no
not
of
on
or
such
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that
the
their
then
there
these
they
this
to
was
will
with

Metadata Manager ignores the common words when you include them in the search criteria. You can 
customize the list of words to ignore in searches by updating following file:

<Informatica services installation directory>\services\shared\jars\pc\classes\stopwords.txt

For more information about the stopwords.txt file, see the Metadata Manager Administrator Guide.

Special Characters in Patterns
Metadata Manager recognizes special characters in certain text patterns. This allows you to index and 
search for text strings such as email addresses or IP addresses.

Metadata Manager recognizes the following patterns and special characters:

Pattern Description Example

<alphanum>< @ | & ><alphanum> Alphanumeric text separated by an 
ampersand (&) or at (@) symbol. 
Sometimes used in company names.

MB&B
Shop@Home

<alphanum> [< . | - | _ ><alphanum>] @ 
<alphanum> [< . | - > <alphanum>]...

Alphanumeric text separated by the at (@) 
symbol allows the following:
- A period (.), dash (-) or underscore (_) 

before the at (@) symbol
- One or more periods or dashes after the 

symbol when followed by additional 
alphanumeric text.

Used for email addresses.

l_cherofsky@infa.com
b-chandra@my-co.jp

<alphanum> < . > <alphanum> 
[< . > <alphanum>]...

Alphanumeric text separated by a period 
(.). Used for host names or IP addresses.

my.informatica.com
555.555.5555
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Search Operators
You can use search operators to logically combine search terms.

The following table describes the search operators that you can use:

Search 
Operator

Description Example

&& Narrows a search by including both search terms. Equivalent to the 
AND logical operator.

sales data && data 
sales 

|| Broadens a search by including either one of the search terms. 
Equivalent to the OR logical operator.

sales data || sales 

! Narrows a search by excluding a search term. Equivalent to the NOT 
logical operator.

sales data ! data 
sales 

+ Requires that the search term after the plus sign (+) exists within the 
search results.

+sales data 

- Excludes the search term after the dash (-) from the search results. sales -data 

Wildcard Characters
You can use wildcard characters to define one or more characters in a search. You can use a wildcard 
character as the first character in a search query.

Use wildcard characters in basic searches and in advanced searches that use an "is" search condition. You 
do not need to specify a wildcard character in advanced searches that use a "contains" or "starts with" search 
condition.

The following table describes wildcard characters that you can use:

Wildcard 
Character

Description

* Represents a string of characters. For example, when you search for sale*, Metadata Manager 
returns objects named sale, sales, and salescode.

? Represents a single character. For example, when you search for sa?es, Metadata Manager 
returns objects named sales and saves.

You can combine wildcard characters in a search. For example, to search for objects named sales_monthly, 
you can use sa?es*.

Quotation Marks
You can use quotation marks (“ ”) to search for an exact keyword match. When you enclose a search query 
in quotation marks, Metadata Manager returns only objects with a property that matches the keyword 
exactly.
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Fuzzy Searches
A fuzzy search finds approximate matches.

To use a fuzzy search, use the tilde character (~) at the end of a single keyword. For example, to search for 
an object similar in spelling to roam, use the following syntax:

roam~
Metadata Manager returns objects named foam and roams.

Boosting a Search Keyword
Metadata Manager lists search results in the order of relevance. If you search for multiple keywords, you can 
boost a keyword so that Metadata Manager lists results using that keyword as more relevant.

To boost a keyword, use the caret character (^) with a number representing the boost factor after the 
keyword that you want to boost. The higher the boost factor, the more relevant the keyword is. For example, 
you are searching for Employee ID and you want the keyword ID to be more relevant. Use the following 
syntax:

Employee ID^4
By default, the boost factor is 1.

Searching in Different Languages
The Metadata Manager installation provides analyzers in several languages. During installation, Metadata 
Manager selects an analyzer based on the system locale.

You can change the analyzer Metadata Manager uses to search and create indexes in a different language.

Saved Searches
When you perform an advanced search, you can save the search query. Save the search query so that you can 
run the search again. When you run a saved search, Metadata Manager displays the search query and the 
search results in the Search Results panel. You can minimize and restore the Search Results panel.

Metadata Manager displays search results based on the priority assigned in the searchpriorities.xml file. 
Administrators can use this file to configure the priorities of saved searches and other entities in the search 
results. For more information about the searchpriorities.xml file, see the Metadata Manager Administrator 
Guide.

Metadata Manager displays the name, class, and location of all objects in the search results, including saved 
searches. Click a saved search to view it in the Shortcuts view. You can also right-click a saved search in the 
search results to complete additional tasks.

The following table describes the commands and the tasks that you can perform on saved searches:

Command Task

Run Search Run a saved search.

Edit Search Edit the search criteria.
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Command Task

Delete Delete the search.

Rename Rename the search.

Duplicate Duplicate the saved search so that you can create similar searches.

Export Export the search criteria to a PDF file, an XML file, or an Excel file.

Email to Email the search criteria to yourself or to another person.

Refresh Refresh the search results.

Saving Searches
You can save the search query for an advanced search. You can access a saved search from the Shortcuts 
view.

1. On the menu bar of the Browse tab, select Advanced Search in the Search list. 

The Advanced Search panel appears.

2. In the Advanced Search panel, configure all search properties. 

3. Click the Save button. 

The New Saved Search window appears.

4. Enter a name and optional description for the search query. 

5. Select the folder where you want to save the search. 

By default, Metadata Manager uses the My Saved Searches folder in the Shortcuts view.

6. Click OK. 

Metadata Manager saves the search query in the folder that you selected.

Running Saved Searches
You can run a saved search from the Shortcuts view or from the Search Results panel.

1. Select a saved search query. 

Metadata Manager displays the search properties in the Details panel.

2. Click Run Search. 

Metadata Manager displays the search criteria in the Advanced Search panel and the search results in the 
Search Results panel.

Editing Saved Searches
You can edit the criteria for a saved search from the Shortcuts view or from the Search Results panel. After 
you edit a search, you can run the search again to view updated results.

1. Select a saved search query. 

Metadata Manager displays the search properties in the Details panel.

40       Chapter 3: Searching Metadata



2. Click Edit Search. 

Metadata Manager displays the search criteria in the Advanced Search panel.

3. Edit the search criteria. 

4. Click the Save button. 

The New Saved Search window appears.

5. Optionally, update the search name, description, or folder. 

6. Click OK. 

If you do not change the search name or folder, Metadata Manager prompts you to overwrite the existing 
search query. Click OK to save the changes to the search criteria.

If you change the search name or folder, Metadata Manager saves the changes in a new saved search.

Renaming Searches
You can rename a saved search from the Shortcuts view or from the Search Results panel.

1. Right-click a saved search query and click Rename. 

The Rename Saved Search window appears.

2. Enter a new name and click OK. 

Metadata Manager updates the search query name in the Shortcuts view.

Troubleshooting Searches

My search results include irrelevant searches and an error appears in the Metadata Manager log: 
ERROR UserIdentifierFilter - org.apache.lucene.search.BooleanQuery$TooManyClauses.
The search query you defined returns more than 1,024 results. Add more specific keywords or search 
conditions before you run the query again.
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C h a p t e r  4

Working with Shortcuts and 
Folders

This chapter includes the following topics:

• Working with Shortcuts and Folders Overview, 42

• Working with Shortcuts, 43

• Working with Folders, 45

Working with Shortcuts and Folders Overview
Shortcuts are pointers to metadata objects, categories, business terms, and saved search queries in 
Metadata Manager. Use shortcuts and folders to organize objects. When you browse or search objects, you 
can create shortcuts to the objects and store the shortcuts in folders. You can then share folders with other 
Metadata Manager users. Use shortcuts to view commonly accessed objects. Use folders to group shortcuts 
for objects in a project.

For example, you want to analyze a set of Oracle tables and views for an Oracle resource. To avoid browsing 
the entire metadata catalog to access a particular table or view, create shortcuts to the Oracle tables and 
views that you are interested in.

You manage shortcuts and folders in the Shortcuts view. The Shortcuts view includes native folders and the 
shortcuts and folders you create. From the Shortcuts view, you can add and edit shortcuts and create, edit, 
share, and search folders.

Use the Shortcuts view to complete the following tasks:

• Manage shortcuts. Create shortcuts to metadata objects, add metadata objects to shortcuts, and edit 
existing documents.

• Manage folders. Create folders to organize metadata objects, edit folder properties, delete folders, and 
share folders with other users.

Note: After you create or configure a shortcut or folder, you can move it to a different folder. Select the 
shortcut or folder and drag it to the new location.

Related Topics:
• “Working with Shortcuts” on page 43

• “Working with Folders” on page 45
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Shortcut and Folder Properties
When you create or edit a shortcut or folder, you configure the properties.

The following table describes the shortcut and folder properties that you configure:

Property Description

Name Name of the shortcut or folder.

Description Description for the shortcut or folder.

Location Location of the shortcut or folder saved in a folder.
Note: When you configure the shortcut or folder location, you can add it to any shared folder to which 
you have access.

Working with Shortcuts
You can perform the following tasks when you work with shortcuts:

• Create a shortcut. Create a shortcut in a folder.

• Add a metadata object to a shortcut. Select a metadata object and add it to shortcuts.

• Edit a shortcut. Edit shortcut properties.

• Perform additional Metadata Manager tasks. Tasks include running data lineage analysis and exporting a 
data lineage diagram.

Creating a Shortcut
To create a shortcut, configure the shortcut name, description, and the object to which you want to create the 
shortcut.

To create a shortcut:

1. In the Shortcuts view, select the folder that you want to create the shortcut in, and click Actions > New > 
Shortcut. 

The New Shortcut window appears.

2. Enter the shortcut properties and select the object in the metadata catalog or business glossary. 

3. Click OK. 

Note: You cannot add logical groups as a shortcut. For example, an Oracle resource uses logical groups 
to organize tables and indexes. You cannot add these objects as a shortcut.

Adding a Metadata Object to Shortcuts
You can select a metadata object and add it to shortcuts from the following locations:

• Catalog view

• Glossary view

• Details panel

Working with Shortcuts       43



• Search results

• Data lineage analysis

To add an object to the Shortcuts view:

1. Select the object that you want to create the shortcut to. 

2. Click Actions > Add to Shortcuts. 

The Add to Shortcuts window appears.

3. Enter the name and description and select the folder to create the shortcut in. 

4. Click OK. 

Editing Shortcut Properties
Edit the shortcut properties to change the name and description of the shortcut and the location of the folder 
to save the shortcut.

To edit properties for a shortcut:

1. Select the shortcut in the Shortcuts view. 

2. Click Actions > Rename. 

The Rename window appears.

3. Configure the shortcut properties and the location of the shortcut. 

4. Click OK. 

Tasks in Shortcuts View
Use the Actions menu and the right-click menu in the Shortcuts view to complete additional tasks on shortcut 
objects.

The following table describes the commands and the tasks that you can perform:

Command Task

Run Lineage View data lineage analysis on shortcut object.

Export Lineage Export a data lineage diagram for a shortcut object to a Microsoft Excel file or a SVG file.

Show in Catalog
Show in Glossary

Find a metadata object in the metadata catalog hierarchy or find a category or business term in 
the business glossary. Use this option to avoid browsing for a particular object in the catalog or 
business glossary hierarchy. You can also click the icon in the search results toolbar.

Edit properties Edit properties for a custom metadata object or metadata object for which you added a custom 
attribute.

Delete Delete shortcuts and folders.

Duplicate Duplicate shortcuts and folders.

Refresh Refresh the Shortcuts view to see changes made by other users.
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Related Topics:
• “Metadata Catalog” on page 19

• “Editing Metadata” on page 48

• “Working with Data Lineage” on page 56

• “Metadata Export” on page 74

Working with Folders
The Shortcuts view contains the default user folder and the folders you create. You can perform the following 
tasks when you work with folders:

• Create a folder. Create a folder to store shortcuts.

• Edit a folder. Edit folder properties.

• Configure folder permissions. Share the contents of a folder with other users.

• Search within a folder. Search for metadata objects in a folder.

The following table describes the user folders that Metadata Manager includes:

Folder Type Description

Personal Folder Folder for the currently logged in user. You can create shortcuts and folders within this 
folder. You cannot delete or rename this folder. Folder is named <user name> [Native].

My Saved Searches Default folder for saved search queries. You can rename or delete this folder.

Shared Folders Contains personal folders shared by you or other users. You can create or delete the 
folders within this folder.

Creating a Folder
Create a folder to save shortcuts to common objects and saved searches.

To create a folder:

1. In the Shortcuts view, select the folder you want to create the folder in. 

2. Click Actions > New > Folder. 

The New Folder window appears.

3. Enter the folder properties. 

4. Click OK. 

Editing a Folder
Edit a folder to change the name, description, or location of the folder.

To edit a folder:

1. In the Shortcuts view, select a folder. 

2. Click Actions > Rename. 
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The Rename Folder window appears.

3. Configure the folder name and description. 

4. To configure the folder location, click Browse. 

The Browse window appears.

5. Select the location of the folder and click OK. 

6. Click OK. 

Configuring Folder Permissions
You can configure folder permissions to share a folder with other users. You set the permission level for 
Metadata Manager users and groups on the folder. You can add other users to set permissions for specific 
users.

Use the Share Folder window to set permissions for users and groups on a folder.

The following table describes the permissions you can assign to users on a folder:

Permission Description

Make changes and share Make changes to the folder and share the folder with other users and groups. For 
example, the user can add shortcuts and share the folder with other users.

Make changes Edit folder properties and add shortcuts.

View contents View the contents of the folder.

No access No access on the folder. Default permission for all users and groups. You can also use 
this option to unshare a folder.

To share a folder:

1. In the Shortcuts view, select a folder. 

2. Click Actions > Share. 

The Share Folder window appears.

3. Enter the share name. 

4. Under User/Group, set permissions for all users and groups on the folder. 

5. Optionally, to add users or groups to the share list, select the user or group, select a permission, and 
click Add. 

The user or group and the configured permission appears under User/Group.

6. Optionally, click Remove to remove permissions for users and groups. 

7. Click OK. 

Searching Within a Folder
To search for metadata objects in a folder:

1. In the Shortcuts view, select a folder. 

2. Click Actions > Search. 

Metadata Manager sets the search location to the current folder.
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3. Enter the search criteria. 

4. Click Go. 

Working with Folders       47



C h a p t e r  5

Editing Metadata
This chapter includes the following topics:

• Editing Metadata Overview, 48

• Comments, 48

• Links, 49

• Relationships, 51

Editing Metadata Overview
Use the Details panel to add comments and links and to create and delete relationships. Metadata Manager 
stores all comments, links, and relationships in the Metadata Manager warehouse.

You can add comments and links to metadata objects in the metadata catalog. You can also add comments 
to categories and business terms in a business glossary. You can create and delete relationships for custom 
metadata objects and for business terms.

Comments
You can add comments to metadata catalog objects and business glossary objects. Metadata Manager 
stores the comments in the Metadata Manager warehouse and displays them when you view an object.

Metadata Manager displays the most recent comment first. Metadata Manager includes the author name and 
date and time for the comments. Metadata Manager uses the name of the currently logged in user as the 
author of the comment.

You can view, add, and delete comments for an object in the Details panel. You cannot edit existing 
comments. To change a comment, you must delete the comment and add it again. Comments are limited to 
4,000 characters.

Note: Metadata objects with a large number of comments may decrease performance when you access the 
object.
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Adding Comments
To add a comment:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, under Comments, click Add. 

The Add Comments window appears.

3. Enter the text for the comment. 

4. Click Add. 

Metadata Manager adds the comments to the list of comments for the object.

Deleting Comments
You can delete comments that you add. An administrator can delete any comment.

To delete a comment:

1. Select a metadata object. 

2. In the Details panel, click the Delete icon next to the comment that you want to delete. 

Links
A link is a hyperlink to a document or web page. Use links to extend the information available about a 
metadata object, category, or business term.

You can add a link to a document located on a company intranet, shared drive, or web address. You can add a 
link to any document type that can be opened by other Metadata Manager users.

When you add a link, Metadata Manager includes the author name, date, and time under the link. Metadata 
Manager uses the name of the currently logged in user as the author of the link.

You can view, add, edit, and delete links for an object in the Details panel. Metadata Manager displays the 
most recent additions first.

The following table describes the information that you configure when you add or edit a link:

Property Description

Name Name of the link. The name appears as a link to the linked document after you add it.

Description Description for the link. The description appears under the link to the document after you add it.

URL/Web address Location of the document or web site address.

Link Syntax
The syntax you use when you enter the address of the document depends on the location of the document 
and the browser you use when you log in to Metadata Manager. For example, you can link to documents in a 
shared directory on Internet Explorer. In Firefox, the link may not work.
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Any link must be accessible to the client machines of all Metadata Manager users. For example, if you create 
a link to a shared directory, the shared directory must be accessible to the client machines for Metadata 
Manager users.

The following table describes the link syntax:

Link Type Syntax

URL http://<address> or https://<address>

FTP ftp://<address>

Shared Directory \\<machine name>\<directory>

Note: Metadata Manager adds http:// to any link that does not specify the link syntax.

Local Links
Local links are links to a document that is on the machine where the Metadata Manager Service runs. To 
create a local link, copy the document to the following location:

<Informatica installation directory>\services\MetadataManagerService\mmapps\mm
When you create the link to the document, use the following URL:

http|https://<Metadata Manager Service host name>:<port number>/mm/<document name>

Adding Links
You can add a link to any metadata object in the metadata catalog.

To add a link:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, under Links, click Add. 

The Add Link window appears.

3. Enter the required properties. 

4. Click OK. 

Editing Links
You can edit the name, description, or the location of a link.

To edit a link:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, under Links, click the Edit icon next to the link. 

The Edit Link window appears.

3. Edit the link properties. 

4. Click OK. 

Deleting Links
You can delete links that you add. Administrators can delete any link.
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To delete a link:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, under Links, click the Delete icon next to the link. 

Relationships
Relationships are associations between metadata objects in Metadata Manager. When you run data lineage 
analysis, Metadata Manager uses relationships to show how objects are associated to other objects in the 
metadata catalog. Metadata Manager displays relationships when you view metadata object details.

Metadata Manager creates relationships between metadata objects when you load metadata for packaged or 
universal resources. For example, you load metadata for a PowerCenter resource. Metadata Manager creates 
a parent-child relationship between a port and the transformation that contains the port. In addition, 
Metadata Manager creates a parent-child relationship between the transformation and the mapping that 
contains the transformation.

You can create relationships for custom metadata objects. For example, you add a metadata object to a 
custom resource. The source for the custom metadata object originates in an Oracle resource. You want to 
view the relationship between the custom metadata object and the Oracle resource in a data lineage diagram. 
Create a relationship between the objects and run data lineage analysis to view the relationship.

The method you use to create a relationship depends on the number of objects you want to create 
relationships from:

Single metadata object

Use the Details panel to create a relationship from a single metadata object.

Multiple metadata objects

Use the Object Relationships Wizard to create relationships from multiple metadata objects.

Note: Relationships between metadata objects are object-level relationships. Before you create an object-
level relationship between metadata objects, you must create a class-level relationship between the classes 
for the metadata objects. For more information about creating class-level relationships, see the Metadata 
Manager Custom Metadata Integration Guide.

Relationships to PowerCenter Objects
You can create a relationship between a custom metadata object and a PowerCenter object.

Some PowerCenter objects can be used in multiple contexts, used in a single context, or can refer to an 
original object. The information that a data lineage diagram displays depends on the following PowerCenter 
object types that you can associate to a custom metadata object:

• Reusable transformation or session. An object that you can use in multiple contexts.

When you run data lineage analysis on the custom metadata object, the data lineage diagram displays the 
PowerCenter object and all instances of the object.

When you run data lineage analysis on any instance of the PowerCenter object, the data lineage diagram 
displays the associated custom metadata object.

Note: If the reusable object is not used in another PowerCenter object, then the data lineage diagram does 
not display the relationship between the custom metadata object and the reusable object.

• Instance of a transformation or session. An instance of an object used in a single context.
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When you run data lineage analysis on the custom metadata object, the data lineage diagram displays the 
PowerCenter object instance within the context where the instance is used. For example, you relate a 
custom metadata object to a Lookup transformation instance. The data lineage diagram of the custom 
object shows the Lookup transformation instance within its corresponding mapping and session context.

• Shortcut. A reference to an original object.

When you run data lineage analysis on the custom metadata object, the diagram displays the instances of 
the original object and all instances of the shortcuts to the original object.

When you reload the custom or PowerCenter resource, Metadata Manager creates or deletes associations 
based on changes made to the source. For example, you create a relationship between a custom metadata 
object and a reusable PowerCenter transformation that has one instance in a mapping. In the PowerCenter 
source, you add another instance of the transformation to a mapping. When you reload the PowerCenter 
resource, Metadata Manager associates the additional instance of the transformation to the custom 
metadata object.

Creating and Deleting Relationships for a Single Metadata Object
You create a relationship between a custom metadata object and other metadata objects in the Details panel.

You can delete relationships for custom metadata objects that you create. You cannot delete relationships 
between metadata objects for packaged or universal resources.

Creating a Relationship for a Single Metadata Object
To create a relationship:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, click Edit under Related Catalog Objects. 

The Edit Related Catalog Objects window appears. The window displays the object types to which you 
can create a relationship from this metadata object.

3. Search or browse for the metadata object to which you want to create the relationship. 

The Edit Related Catalog Objects window stays open while you select the object.

4. Drag the metadata object into the Edit Related Catalog Objects window. 

5. Click OK. 

Deleting a Relationship for a Single Metadata Object
To delete a relationship:

1. On the Browse tab, select a metadata object. 

2. In the Details panel, click Edit under Related Catalog Objects. 

The Edit Relationships window appears and displays the relationships that you created.

3. Select the relationship you want to delete and click Remove. 

If the metadata object is related to a reusable PowerCenter object, you can delete the relationship to the 
reusable object. Metadata Manager removes the associations to all instances of the object. However, 
you cannot delete the relationship for a single instance of the object.

4. Click OK. 
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Creating and Deleting Multiple Relationships
Use the Object Relationships Wizard to create relationships for multiple metadata objects in a custom 
resource. Use the wizard to find metadata objects that you can create relationships between. If a relationship 
exists, you can use the wizard to delete it.

To use the wizard, select the resources that contain the metadata objects that you want to create 
relationships between. Configure the metadata object property that you want to match. The wizard searches 
for metadata objects in the resources that contain matching properties. The wizard then displays the 
relationships that you can create or delete.

The Object Relationships Wizard searches for metadata objects that meet the following conditions:

Contain class-level relationships

The metadata objects contain class-level relationships to each other.

Contain matching properties

The metadata object property that you specify matches.

To limit the matching objects, use a case-sensitive search or search for metadata objects where the parent 
and child metadata object properties match.

For example, you want to create relationships between objects in a custom resource and tables in an Oracle 
resource. You want the wizard to match names when it searches for objects. The wizard searches the 
metadata objects in both resources. It matches metadata objects that contain class-level relationships to the 
objects in the custom resource and that have the same column name.

Note: You can also use the wizard to create relationships for business terms in a business glossary. Select 
the business glossary as the custom resource.

Creating and Deleting Relationships
To create or delete relationships in a custom resource:

1. In the metadata catalog, select a custom resource. 

2. Click Actions > Object Relationships Wizard. 

- or-

Right-click and select Object Relationships Wizard.

Step 1 of the Object Relationships Wizard appears.

3. In the Associated Resource list, select the level of the custom resource hierarchy that contains the 
objects for which you want to create or delete relationships. 

Metadata Manager shows the resources and objects that have class-level relationships to objects in the 
custom resource. Metadata Manager also displays the parent objects of the metadata objects. Metadata 
Manager displays the parent objects even if they do not have class-level relationships with the objects in 
the custom resource.
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4. Configure the following options: 

Option Description

Include immediate parent while 
doing name-based search

The property of both the parent and child objects to which you want to 
create relationships match the property of the parent and child objects 
you want to create relationships for.

Case sensitive Metadata Manager performs a case sensitive match when it searches for 
matching properties.

5. Click Next. 

Step 2 of the Object Relationships Wizard appears.

6. Select the class attributes for each resource that you want to match. 

For example, to match column names, choose the name attribute for each column class.

7. Click Next. 

The wizard displays the matching objects and selects all relationships.

8. Clear Add for all objects for which you do not want to create a relationship. 

If a relationship exists and you clear the check box, Metadata Manager deletes the relationship.

If the metadata object is related to a reusable PowerCenter object, you can delete the relationship to the 
reusable object. Metadata Manager removes the associations to all instances of the object. However, 
you cannot delete the relationship for a single instance of the object.

9. Click Finish. 

Metadata Manager creates or deletes the relationships.

Rules and Guidelines for Creating and Deleting Multiple Relationships
Use the following rules and guidelines when you work in the Object Relationships Wizard:

• Metadata Manager shows the resources and objects that have class-level relationships to objects in the 
custom resource. Metadata Manager also displays the parent objects of the metadata objects. Metadata 
Manager displays the parent objects even if they do not have class-level relationships with the objects in 
the custom resource.

• The Object Relationships Wizard may show relationships between objects with different parent names 
even though you include objects where the parent and child metadata object properties match.

For example, you create a relationship between a column object named SALARY in a custom resource and 
a column object named SALARY in an Oracle resource. You can create relationships between a synonym 
with a parent name of SALARY_DETAILS_SYNONYM and an Oracle table with a parent name of 
SALARY_DETAILS. SALARY_DETAILS_SYNONYM is a reference to SALARY_DETAILS. The Object 
Relationships Wizard includes both relationships for the column SALARY.

Creating Relationships Example
A custom resource, ACCESS_DB, contains database table objects that have class-level relationships with 
database table objects in an Oracle resource. You want to create relationships between the custom metadata 
objects and the Oracle database table objects.

When you run the Object Relationships Wizard for the ACCESS_DB resource, you specify to match all column 
objects that have the same property name for the table column class.
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The following table shows the relationships that have matching object names:

Object Name Matched Object Name

ACCESS_DB_SOURCE/ CUSTOMER/ SRC_CUSTOMER SCHEMA/ CUSTOMER/ SRC_CUSTOMER

ACCESS_DB_SOURCE/ PRODUCT/ SRC_CUSTOMER SCHEMA/ CUSTOMER/ SRC_CUSTOMER

ACCESS_DB_SOURCE/ PRODUCT/ SRC_CUSTOMER SCHEMA/ PRODUCT/ SRC_CUSTOMER

ACCESS_DB_SOURCE/ PRODUCT/ SRC_CUSTOMER SCHEMA/ SALES/ SRC_CUSTOMER

Metadata Manager searches for parent and child table objects in the ACCESS_DB resource that have the 
same name as the corresponding objects in the Oracle resource.

The following table shows the relationships that have matching parent and child object names:

Object Name Matched Object Name

ACCESS_DB_SOURCE/ CUSTOMER/ SRC_CUSTOMER SCHEMA/ CUSTOMER/ SRC_CUSTOMER

ACCESS_DB_SOURCE/ PRODUCT/ SRC_CUSTOMER SCHEMA/ PRODUCT/ SRC_CUSTOMER
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C h a p t e r  6

Working with Data Lineage
This chapter includes the following topics:

• Data Lineage Overview, 56

• Data Lineage Example, 57

• Accessing Data Lineage, 57

• Data Lineage Generations, 59

• Summary Data Lineage, 60

• Data Lineage Tasks, 62

• Object Handling, 68

Data Lineage Overview
You can view data lineage for objects in the Metadata Manager warehouse. Data lineage shows the origin of 
the data, describes the path, and shows how it arrives at the target. Use data lineage to analyze data flow and 
troubleshoot data transformation errors. You can view the data lineage diagram as HTML 5.

Metadata Manager can trace the data path when a network of applications share and transform the same set 
of data. It uses the metadata that applications store for each transformation procedure to determine how 
each application moves or transforms data. It displays this information in a data lineage diagram.

Metadata Manager can show data lineage for objects in one or more resources. You can view data lineage 
for the following object types:

• Tasks

• Transformations

• Data structures

• Fields

• Reports

• Business terms
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Data Lineage Example
You can use data lineage to analyze how data is transformed in PowerCenter and how the output data is 
used in Business Objects.

You can analyze the data flow at the table level to determine which relational and flat file PowerCenter 
sources populate data in a particular PowerCenter target. You can drill in to the table-level results to 
determine how PowerCenter transforms data at the port level. You can then analyze how and where 
PowerCenter target data is used in Business Objects reports.

PowerCenter and Business Objects do not physically store the data that gets transformed. Instead, the data 
resides in a database. For example, PowerCenter source definitions and target definitions can represent 
database tables. Data lineage includes analysis of the underlying databases.

The following figure shows an example data lineage diagram:

Note: To view links between custom resources and either packaged or universal resources in a data lineage 
diagram, create linking rules for the resources. Or, create a class-level relationship for the custom model 
class. After you create the class-level relationship, add the relationship between the metadata objects.

Related Topics:
• “Relationships” on page 51

• “Object Handling” on page 68

Accessing Data Lineage
You can access data lineage from the Catalog, Glossary, or Shortcuts views. You can also access data 
lineage from a data lineage diagram.

1. Select a metadata object. 

2. Click Actions > Run Lineage. 

Metadata Manager opens the data lineage diagram on a new tab. Metadata Manager marks the 
metadata object from which you generate the diagram with a star icon.
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Data Lineage Diagram Tab
The data lineage diagram displays a visual representation of the data flow and information about the objects 
involved in the data flow. When you run data lineage analysis on a metadata object or a business term, 
Metadata Manager displays the data lineage diagram on a separate tab.

The following image shows the data lineage diagram tab:

1. Task bar
2. Diagram panel
3. Details panel

The data lineage diagram tab contains the following sections:

Task bar

Perform data lineage tasks such as switching between the summary and detail views, finding objects, 
selecting objects, scanning the diagram, zooming in and out, and panning the diagram.

Diagram panel

View the data lineage diagram and view information about objects in the diagram. The data lineage 
diagram shows the direction of data flow from left to right. Metadata Manager marks the source object, 
which is the object from which you generate the diagram, with a star icon.

To view information about an object, hover the pointer over the object. The information that Metadata 
Manager displays when you hover over an object varies based on the object type.

Details panel

View details about the selected object in the diagram. By default, Metadata Manager displays the object 
definition in the Details panel. The object definition includes metadata details such as the object 
properties, related terms, links, comments, related catalog objects, and impact summary.

The Details panel includes a toolbar that you can use to perform the following tasks:

• Display the object definition or audit trail information for the selected object.

• Refresh the object definition or audit trail information.

• View data lineage for the selected object.

• Show a selected object in the metadata catalog or the Glossary view.

• Create a shortcut for the selected object.
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Related Topics:
• “Metadata Details” on page 23

Rules and Guidelines for Accessing Data Lineage
Use the following rules and guidelines when you access data lineage:

• Synchronize metadata in the Metadata Manager warehouse with the metadata in the source repositories. 
If the Metadata Manager warehouse does not have the latest metadata, data lineage diagrams might not 
appear properly. For example, you create a database table and a PowerCenter source definition. If you 
only load the PowerCenter repository, Metadata Manager cannot display lineage from the PowerCenter 
source definition to the database table.

• Verify that the connection assignments for packaged and universal resources have been updated with the 
latest resource information.

• Verify that Metadata Manager has successfully linked matching objects across metadata sources.

• Data lineage analysis is not case sensitive.

• A data lineage diagram only shows details for metadata objects if you configure the object types to 
appear in the metadata catalog. Configure preferences to select which resources in the metadata catalog 
and their corresponding object types that you want to view. Otherwise, the metadata object appears in the 
data lineage diagram but you cannot get details about the object.

Related Topics:
• “Configuring Preferences for the Metadata Catalog” on page 22

Data Lineage Generations
In a data lineage diagram, a generation is a set of resources that are the same upstream or downstream 
distance from the resource that contains the source object. You can configure the number of generations 
that appear when you run data lineage analysis or navigate a data lineage diagram.

Each resource is a separate generation, and each generation can contain multiple resources, depending on 
the number of resources directly linked to the source generation. The resource that contains the source 
object is the source generation from which Metadata Manager displays upstream and downstream 
generations.

Metadata Manager displays one generation of resources both upstream and downstream from the data 
lineage analysis source object. Decrease the number of generations to increase Metadata Manager 
performance when you run data lineage analysis and navigate a data lineage diagram.

The following figure shows three generations for a data lineage diagram where the source and target 
databases are in different generations:
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If the number of upstream or downstream generations are greater than the number you configure to appear, 
Metadata Manager includes arrow buttons in the data lineage diagram. Use the arrow buttons to navigate 
through upstream and downstream generations in the diagram.

Configure the number of generations in the Metadata Manager imm.properties configuration file. For more 
information about the imm.properties file, see the Metadata Manager Administrator Guide.

Summary Data Lineage
When you view a data lineage diagram, Metadata Manager displays a summarized view of the diagram as 
HTML 5. The summary view hides certain resources and also hides transformation logic within PowerCenter 
mappings. To view all resources and all transformation logic, you can switch from the summary view to the 
detail view through the task bar.

The summary view hides the following objects in the data lineage diagram:

• All resources for which the Hide in Summary Lineage option is enabled in the resource configuration 
properties.

• All transformations and transformation instances within PowerCenter mappings that do not provide input 
or output for the mapping.

The summary view has the following advantages:

Reduces the complexity of the data lineage diagram.

The summary view reduces the complexity of the data lineage diagram when you do not need to view 
objects such as transformations within a PowerCenter mapping or intermediate staging databases. For 
example, you run data lineage analysis on a business intelligence report to see where the column data 
originates from. In this case, you are not interested in seeing the PowerCenter mappings that transform 
the source data or the intermediate staging tables. The summary view can hide these objects from the 
data flow.

Reduces the amount of time it takes for Metadata Manager to generate the data lineage diagram.

PowerCenter mappings and mapplets can include hundreds of transformations and staging tables. 
Generating a data lineage diagram that includes hundreds of transformations and staging tables can 
take several minutes. Generating the diagram without the staging tables or transformation details takes 
less time.

Resources in the Summary View
You can choose which resources to hide in the summary view. Hide a resource when the resource contains 
objects such as staging tables that do not affect overall data lineage. To hide a resource and its child objects 
in the summary view of data lineage diagrams, enable the Hide in Summary Lineage option.

You enable the Hide in Summary Lineage option for a resource when you create or edit the resource on the 
Load tab. The Hide in Summary Lineage option appears on the Properties page. The option is disabled by 
default. You can enable this option for any resource. When you enable this option, Metadata Manager hides 
the resource and its child objects in the summary view of all data lineage diagrams.

For example, you have a Tableau report in a universal resource that was generated through the following 
process:

1. Data for the report originates from a Greenplum table and an Oracle table.

2. A PowerCenter mapping transforms the data and loads it to a staging database.
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3. A second PowerCenter mapping transforms the staging data and loads it to a table in a data mart.

4. You query the data mart to generate the Tableau report.

You want to view data lineage for the report, but you are not interested in the data transformation process 
that occurs through the PowerCenter mappings or the staging database. You edit the PowerCenter resources 
and the resource that contains the staging database and enable the Hide in Summary Lineage option. You 
then start data lineage analysis from the Tableau report.

The following image shows the data lineage in the summary view:

To see all of the resources in the data lineage diagram, switch to the detail view.

The following image shows the diagram in the detail view:

Starting Data Lineage Analysis from a Hidden Resource
You can start data lineage analysis from an object in a resource for which the Hide in Summary Lineage 
option is enabled. When you start data lineage analysis on an object in a hidden resource, the summary view 
displays the object, the associated resource, and all instances of the resource.

For example, the Hide in Summary Lineage option is enabled for Oracle resource StagingDB1 which contains 
staging table StgCustData. A PowerCenter mapping writes data to the staging table. When you start data 
lineage analysis from table StgCustData, the summary view displays table StgCustData and all instances of 
resource StagingDB1.

PowerCenter Mappings in the Summary View
By default, when you view a PowerCenter mapping in a data lineage diagram, Metadata Manager hides 
transformation logic within the mapping. Metadata Manager displays the mapping inputs and outputs but 
hides the transformation instances that change the data.

Mapping inputs are the endpoints through which data flows into a mapping. Mapping outputs are the 
endpoints through which data flows out of a mapping. Mapping inputs include source qualifier instances, 
lookup procedure instances, stored procedure instances, and mapplet instances that provide source data for 
the mapping. Mapping outputs are the target definition instances.

If you view a mapping that includes a mapplet instance, Metadata Manager hides the mapplet instance 
unless the mapplet provides source data for the mapping. Mapplets that provide source data for a mapping 
are called source mapplets.

In the summary view, Metadata Manager displays the inputs and outputs for source mapplets but hides the 
transformation instances that change the data. Inputs for source mapplets include source qualifier instances, 
lookup instances, and stored procedure instances. Outputs for source mapplets are the Output 
transformation instances.
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The following image shows the mapping in the summary view:

To see all of the transformation instances within the mapping, switch to the detail view.

The following image shows the same mapping in the detail view:

Starting Data Lineage Analysis from a Transformation Instance
You can start data lineage analysis from a transformation instance that is not a mapping or mapplet input or 
output. For example, you can start data lineage analysis from an Expression transformation instance within a 
mapplet.

When you start data lineage analysis from a transformation that is not an input or output, Metadata Manager 
displays the transformation instance as a standalone object in the data lineage diagram. To see how the 
object is linked to other objects in the data lineage diagram, switch to the detail view.

Switching Between the Summary View and the Detail View
By default, Metadata Manager displays data lineage diagrams in the summary view. You can switch between 
the summary view and the detail view. Metadata Manager retains the summary or detail view setting for the 
data lineage diagram when you close and reopen the diagram within the same session.

To switch from the summary view to the detail view, click Switch to Detail ( ) on the toolbar.

To switch from the detail view back to the summary view, perform one of the following actions:

• Click Refresh and Switch to Summary ( ) on the toolbar.

• Click Actions > Refresh.

When you switch from the detail view back to the summary view, Metadata Manager refreshes the data 
lineage diagram.

Data Lineage Tasks
You can perform different tasks in the data lineage diagram such as view object details, navigate through 
generations, filter objects or classes of objects, and find objects.

You can perform the following tasks in the data lineage diagram:
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View details about an object.

Hover the pointer over an object to view details such as the object label, class, resource name, object 
path, and expression used to transform the data, if applicable. Metadata Manager displays different 
details based on the object type. Select an object to view the object definition in the Details panel.

Expand and collapse objects.

Expand objects to view child objects and relationships to other objects in the diagram.

Navigate generations.

If the number of generations in the diagram are greater than the number you configure to display, you 
can use the single arrow button to navigate through the upstream and downstream resources in the 
diagram. You can use the double arrow button to display all the upstream or downstream generations.

Open the diagram in a new window.

Click the New Window button to open the data lineage diagram in a new browser window.

Filter objects.

Apply filters to remove objects that you are not interested in viewing from the diagram.

Switch between the summary and detail views.

By default, Metadata Manager displays a summarized view of the data lineage diagram. The summary 
view hides resources for which the Hide in Summary Lineage option is enabled and also hides 
transformation logic within PowerCenter mappings. Click Switch to Detail on the toolbar to view all 
resources and all transformation logic. Click Refresh and Switch to Summary on the toolbar to refresh 
the diagram and return to the summary view.

Find objects.

Find metadata objects by name in the data lineage diagram.

Select an object.

Use the Select tool to select an object and view details about the object in the Details panel.

Scan the lineage diagram.

Use the Hand tool to move the diagram and see different parts of the diagram.

Zoom in and out.

Click the Zoom Out and Zoom In buttons to zoom the data lineage diagram one level. Or, select a 
magnification to view the lineage diagram from 12 to 225 percent of normal size.

Pan the lineage diagram.

View different sections of the diagram. Use the Pan window to move the highlighted area and view 
different sections of the data lineage diagram.
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Performing Metadata Manager Tasks in Data Lineage
When you view data lineage, you can perform Metadata Manager tasks from the Actions menu or from the 
right-click menu.

The following table describes the tasks that you can perform:

Command Tasks

Run Lineage View data lineage analysis on an object.

Show in Catalog/
Glossary

Find a metadata object in the metadata catalog hierarchy or find a business term in the 
glossary. Use this option to avoid browsing the metadata catalog or glossary to find a 
particular object.

Add to Shortcuts Add a shortcut to a folder in the Shortcuts view for the object. You can also click the Add to 
Shortcuts icon in the search results toolbar.

Expand All Expand the object and all child objects in the data lineage diagram.

Show/Hide Business 
Names

Show or hide the business name as the object name in the data lineage diagram and Details 
panel.

Edit properties Edit properties for a custom metadata object or metadata object for which you added a 
custom attribute.

Search Sets the search location as the current metadata object hierarchy. After you select this 
command, use the Search section to search for metadata objects in the currently selected 
hierarchy in the data lineage diagram.

Refresh Refresh the data lineage diagram. Refresh the diagram to reset it to the default view or to 
see changes made by other users.

Manage Filter View all of the filters that you apply to the diagram, and optionally remove any filter that you 
apply.

Set Permissions for 
this Object

Configure permissions for metadata objects on the Permissions tab.

Export Export a lineage diagram to a Microsoft Excel file or a SVG file.

Email to Send an email with the diagram in SVG format.

Related Topics:
• “Metadata Catalog” on page 19

• “Working with Shortcuts” on page 43

• “Editing Metadata” on page 48

• “Working with Data Lineage” on page 56

• “Metadata Export” on page 74

Viewing Object Details
To view more information about an object in the Details panel, select the object. You can also move the 
pointer over an object to view object details. The details that appear depend on the object.
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You can select Show Business Names in the Actions menu to view the business name of the metadata object 
in the Details panel.

The following table describes the properties that appear for all objects:

Property Description

Name Name of the object.

Description Object description.

Business Name Business name of the object.

Class Class type of object.

Source Creation Date Date the object was created in the metadata source.

Source Update Date Last date on which the object was updated in the metadata source.

MM Creation Date Date the object was created in Metadata Manager.

MM Update Date Last date on which the object was updated in Metadata Manager.

Location Location of the object in the metadata catalog.

Expression Expression of the object, if applicable.

Expanding and Collapsing Objects
You can expand and collapse objects in a data lineage diagram.

Use the following icons to expand and collapse objects:

Expand (+)

To display the immediate child objects of an object, click the plus sign (+) next to the object.

Collapse (-)

To hide the child objects of an object, click the minus sign (-) next to the object.

To display all of the child objects of an object, select the object and choose Actions > Expand All.

Filtering Objects
You can filter objects in the data lineage diagram. Filter objects to remove them from the data lineage 
diagram. You can filter individual objects or filter all objects of a particular class. You can remove any filter 
that you apply.

Filter objects to reduce the complexity of the data lineage diagram. For example, you run data lineage 
analysis on a relational table to determine which columns are used in business intelligence reports. The 
relational table is created from a PowerCenter mapping, and the mapping has multiple sources. Because you 
do not need to know how the table is created, you can filter the PowerCenter mapping. When you filter the 
mapping, Metadata Manager removes the mapping and the mapping source objects from the data lineage 
diagram.
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Alternatively, you view a data lineage diagram that contains many objects that are linked to business glossary 
terms. You do not need to view the business terms to complete your analysis. You can use a filter to remove 
all of the business terms from the diagram.

When you filter an object, Metadata Manager removes the filtered object from the data lineage diagram. 
Metadata Manager also removes the upstream or downstream objects that are in the same data path as the 
filtered object.

For example, you run data lineage analysis from a PowerCenter mapping with the following lineage:

Microsoft SQL Server table → PowerCenter mapping* → Oracle table → Business Objects report

If you filter the Oracle table, Metadata Manager removes the Oracle table and the downstream Business 
Objects report from the data lineage diagram.

Metadata Manager does not remove the upstream or downstream objects if they are in the data path of other 
objects.

You can filter any lineageable object in the data lineage diagram except for the source object, its parent 
objects, or its child objects.

Metadata Manager retains the filters for the data lineage diagram when you close and reopen the diagram 
within the same session. Metadata Manager also retains filters when you navigate through generations and 
when you switch between the summary and detail views. If you refresh the data lineage diagram, Metadata 
Manager removes all filters.

Rules and Guidelines for Filtering Objects
Use the following rules and guidelines when you apply filters to a data lineage diagram:

You cannot filter the source object, its parent objects, or its child objects.

For example, if you run data lineage analysis on a relational column, you cannot filter the column or the 
table that contains the column. If you run data lineage analysis on a relational table, you cannot filter the 
relational table or any column in the table. You cannot filter synonyms of the table.

Alternatively, you run data lineage analysis on a Cognos query, and then you filter all Cognos queries. 
Metadata Manager removes all of the Cognos queries except for the query from which you generated the 
diagram.

You cannot filter non-lineageable objects.

For example, you cannot filter repositories or relational schemas, even though these objects appear in 
the data lineage diagram.

Filtering an object also filters the upstream or downstream objects that are in the same data path as the filtered object.

For example, you run data lineage analysis from an Oracle view with the following lineage:

ERwin table → Oracle table → Oracle view* → PowerCenter mapping → Microsoft SQL Server table

If you filter the PowerCenter mapping, Metadata Manager removes the PowerCenter mapping and the 
downstream SQL Server table from the data lineage diagram. If you filter the Oracle table, Metadata 
Manager removes the Oracle table and the upstream ERwin table from the diagram.

Metadata Manager does not filter upstream or downstream objects that are in the data path of a non-filtered object.

For example, you run data lineage analysis from Oracle table CUSTOMERS with the following lineage:

66       Chapter 6: Working with Data Lineage



If you filter the PowerCenter mapping Map_lkp, Metadata Manager removes the mapping but not the 
downstream EMPLOYEES table. Metadata Manager does not remove the downstream table because it is 
in the data path of the mapping that is not filtered.

When there is a loop in the data lineage diagram, Metadata Manager filters upstream or downstream objects based on 
the direction of lineage.

For example, you run data lineage analysis from a PowerCenter mapping with the following lineage:

This mapping writes data back to Oracle table EMP.

If you filter Oracle view V_EMP, Metadata Manager removes Oracle view V_EMP and the upstream link to 
Oracle table EMP. The data lineage diagram still shows the downstream link to Oracle table EMP as 
follows:

When you filter one instance of a reusable PowerCenter object, the filter does not affect instances of the object in other 
containers.

For example, a reusable PowerCenter transformation appears in multiple mappings in a data lineage 
diagram. When you filter an instance of the transformation in one mapping, Metadata Manager does not 
filter instances of the transformation in other mappings.

Applying Filters
Apply filters through the data lineage diagram Actions menu or through the right-click menu. You can filter an 
individual object or filter all objects of a particular class.

1. To remove an object from the data lineage diagram, select the object and select Actions > Filter object. 

Alternatively, you can right-click the object and select Filter object.

2. To remove all objects of a particular class, select an object of that class in the data lineage diagram and 
select Actions > Filter objects of this type. 

Alternatively, you can right-click the object and select Filter objects of this type.
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Removing Filters
Remove filters through the data lineage diagram Actions menu.

1. Click Actions > Manage Filter. 

The Manage Filters dialog box appears. The dialog box lists the individual objects and the classes that 
are filtered from the data lineage diagram.

2. Click X next to the filter that you want to remove. 

Tip: When objects with the same name appear in the Filtered Objects list, hover the pointer over an 
object to display the full object path.

3. To remove all object or class filters, click X in the header area of the Filtered Objects or Filtered Classes 
list. 

4. Click Apply. 

Finding Objects
You can find object names that appear in the data lineage diagram. When you search for an object, Metadata 
Manager displays the list of objects that match the search criteria and highlights the object in the data 
lineage diagram.

Metadata Manager searches for objects that are visible in the data lineage diagram. If an object is collapsed 
and you expand the diagram, Metadata Manager adds the object to the search results list.

1. Click the Find icon in the data lineage toolbar. 

The Find box appears on the toolbar.

2. Enter at least one character in the Find box and click Find. 

Metadata Manager displays a list of visible objects that match the search criteria and highlights the 
objects in the data lineage diagram.

Object Handling
You can view data lineage for metadata objects and custom metadata objects in the Metadata Manager 
warehouse.

You can view data lineage for the following source repository objects that Metadata Manager extracts:

• Tasks. Represents a transformation that moves data between data structures. For example, a 
PowerCenter mapping may be used by multiple sessions. In a PowerCenter mapping, each session is a 
task and the mapping is the transformation for a task.

• Transformations. Determines how data flows between data structures in a single repository. 
Transformations can be reusable or non-reusable. A transformation is reusable if multiple tasks use the 
transformation. Transformations include PowerCenter mappings and database views.

• Data structures. Contains fields that contain data. Data structures include PowerCenter source and target 
definitions and Source Qualifier transformations, database tables and views.

• Fields. Components of data structures. Fields contain or represent data. A database column contains 
data. A database view column represents data contained in a database table column. Fields include 
columns for database tables and views, ports of PowerCenter transformations, and matrix and attributes 
in business intelligence reports.
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You can also view resources in the data lineage diagram. Resources include application, business 
intelligence, data integration, data modeling, and relational resource types. You cannot start data lineage 
from a resource in the metadata catalog.

Handling Source Repository Objects
The following sections describe how Metadata Manager handles and displays source repository objects.

Parent Objects
The lineage diagram displays the parent of each object. If the container of the object is not the parent, the 
lineage diagram displays the path of the object when you move the pointer over the object.

Stored Procedures
Stored procedures appear as data structures. Metadata Manager treats database stored procedures as 
transformations, source, or target structures in the diagram.

Public Synonyms
Public synonyms appear for all database tables.

PowerCenter Connections
Metadata Manager can display data lineage between PowerCenter repositories and flat file or database 
sources and targets. If the relational connection is defined in PowerCenter, Metadata Manager can extract 
the connection information to create lineage between PowerCenter and the database.

If the relational connection is defined in a parameter file, Metadata Manager can extract the connection 
information from the parameter file and load it to the Metadata Manager warehouse. To extract connection 
information from a parameter file, configure the parameter file on the Load tab.

Reusable Transformations
A reusable transformation can be used multiple times in the source repository. Metadata Manager displays 
each reusable transformation with its corresponding task. It displays the task to show the context in which 
the transformation is used.

For example, Metadata Manager shows a PowerCenter mapping with its corresponding session task. 
Metadata Manager does not show the task for non-reusable transformations.

PowerCenter Source Qualifier Transformations
If you create connection assignments between a relational database source and PowerCenter, data lineage 
displays links between source relational tables and PowerCenter Source Qualifer transformations. Data 
lineage does not display links between source relational tables and PowerCenter source definitions.

Business Glossary Objects
Metadata Manager shows data lineage for business terms. The data lineage diagram for a business term 
shows data lineage to all objects related to the business term.

Metadata Manager does not show data lineage for categories.
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C h a p t e r  7

Sharing Metadata
This chapter includes the following topics:

• Sharing Metadata Overview, 70

• Email, 72

• Metadata Export, 74

• Viewing Data Lineage in Microsoft Excel, 75

Sharing Metadata Overview
You can send an email with metadata or export metadata from the Catalog view, Shortcuts view, or data 
lineage diagram.

When you send an email or export, you can choose the following file types:

• Adobe PDF

• HTML

• Microsoft Excel

• Scalable Vector Graphics (SVG) file

The options available depend on the type of metadata you select or display.

The following table describes the email options:

Metadata Displayed or Selected Description

Metadata catalog objects
Shortcut objects

Send an email with an attachment in PDF, HTML, or Excel format. You can choose 
to include child objects in the attachment.

Data lineage diagram Send an email with the diagram in SVG format.
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The following table describes the export options:

Metadata Displayed or 
Selected

Description

Metadata catalog objects
Shortcut objects

Export the metadata objects to a PDF, HTML, or Excel file. You can choose to 
include child objects in the exported file.

Data lineage diagram Export the diagram to a SVG file or Excel file, or print the diagram.

Related Topics:
• “Email” on page 72

• “Exporting Metadata Objects” on page 74

• “Exporting a Data Lineage Diagram” on page 74

Metadata Information
When you send results in an email or export metadata objects, you can choose to include the following object 
properties in the attached or exported file:

• Basic and advanced object properties

• Comments

• Links

• Related catalog objects

• Related terms

• Related categories

• Impact summary downstream

• Impact summary upstream

Before You Send Email
Before you can send email, you must configure the host name and port number of the outgoing mail server. 
You must also set the email address in your user profile or configure a default sender address in 
imm.properties.

Before you can send email, complete the following tasks:

Configure the host name and port number of the outgoing mail server.

Configure the outgoing mail server through the Domain tab of the Administrator tool. Configure the mail 
server host name and port number in the SMTP settings for the domain. Metadata Manager sends email 
to email addresses that are registered under this mail server.

Configure the email address in your user profile or the default sender address in imm.properties.

By default, Metadata Manager uses the email address in your user profile in the Administrator tool as the 
sender address. If your user profile does not contain an email address, Metadata Manager uses the 
default sender address configured in imm.properties. If your user profile contains no email address and 
imm.properties contains no default sender address, you cannot send email from Metadata Manager.
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Before You Export
To generate PDFs, you must configure Metadata Manager to use fonts that can represent multibyte 
characters in another language. For example, the default font for Metadata Manager is Verdana, which 
cannot represent Japanese characters.

Metadata Manager uses the font information in a Cascading Style Sheet (CSS) file when it creates PDFs. By 
default, Metadata Manager uses publish.css in the following location:

<Informatica installation directory>\services\MetadataManagerService\mmapps\mm\css
To configure the fonts for Metadata Manager, complete the following steps:

1. Open publish.css in a text editor and change the value of all font-family properties for all style 
declarations to a compatible font family. For example, for Japanese, make the following change:

<style declaration> {
...
font-family:Arial Unicode MS;
...
}

You can enter multiple font names, separated by commas. In general, Metadata Manager will use the 
first font in the font family when you export to PDF and all fonts when you export to HTML.

2. Save publish.css.

3. Verify that the Java Run-time Environment (JRE) for Metadata Manager uses the locale of the language 
you want to generate the PDF in. Typically, the JRE uses the locale of the machine it runs on.

4. Optionally, add the property PDF.Font.MultibyteList=<font names> to the imm.properties file. You can 
also enter multiple font names, separated by commas.

Note: If you modify imm.properties, you must disable and enable the Metadata Manager Service for the 
change to take effect.

Email
You can email metadata catalog objects and data lineage information. You cannot email business glossary 
objects.

When you send an email with metadata, you configure email properties.

The following table describes the properties that you configure when you send an email:

Property Availability Description

To Metadata objects
Data lineage analysis

Email address of recipients. Separate multiple email addresses with 
commas.

Cc Metadata objects
Data lineage analysis

Email address of recipients that you want to receive a courtesy copy 
of the email. Separate multiple email addresses with commas.

Subject Metadata objects
Data lineage analysis

Subject of the email. Default is the name of the object or "Lineage for 
<object name>."
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Property Availability Description

From Metadata objects
Data lineage analysis

Sender email address. Metadata Manager populates this field with the 
email address in your user profile. If your user profile does not have 
an email address, Metadata Manager uses the default sender email 
address in imm.properties.

Attachments Metadata objects
Data lineage analysis

Additional files to attach to the email. Click Add files and select the 
files to add. You can include up to three attachments with a total size 
of 2 MB.

Select a file format Metadata objects Type of file to which you want to export the objects.

Select items to be 
included

Metadata objects Objects to send in the email. Select one of the following options:
- Selected item. Send email with the object you selected.
- Select item and its subitems. Send email with the object you 

selected and its child objects.

Select information 
to be included with 
each item

Metadata objects Information to include in the email for each object.

Message text Metadata objects
Data lineage analysis

Optional message text to include in the email.

Related Topics:
• “Metadata Catalog Tasks” on page 22

• “Working with Shortcuts” on page 43

• “Relationships” on page 51

• “Working with Data Lineage” on page 56

• “Metadata Export” on page 74

Sending Email
To send an email with metadata, configure email options, configure the file type, and select the objects and 
object properties to include.

1. Select a metadata object or view a data lineage analysis. 

2. Click Actions > Email to. 

The Email To window appears.

3. Enter the email options. 

4. Click Add Files or Add More Files to add attachments. 

Click Browse, select a file, and click OK.

5. If you send an email with objects, configure the file type. 

6. If you send an email with multiple objects, select the objects and properties to include. 

7. Optionally, enter text to include in the email. 

8. Click Send. 
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Metadata Export
You can export metadata catalog objects, shortcut objects, and data lineage diagrams. You cannot export 
business glossary objects.

You can export metadata objects to a PDF, HTML, or Excel file. You can export details about metadata 
objects. For example, you can export object properties. Use the Export window to export objects.

The following table describes the properties you configure when you export metadata:

Property Description

Select a file format Type of file to which you want to export the objects.

Select items to be included Objects to export. Select one of the following options:
- Selected item. Export the object you selected.
- Select item and its sub-items. Export the object you selected and its child 

objects.

Select Information to be Included 
with each item

Information to include in the file for each object.

You can export a data lineage diagram as a SVG image file or as Microsoft Excel file, or you can print it. If you 
export to a SVG file, Metadata Manager names the file lineage.svg.

When you export to a SVG file, Metadata Manager exports the visible objects. When you export the data 
lineage diagram as an Excel file, Metadata Manager exports an expanded diagram. Based on the size of the 
diagram, Metadata Manager might take a while to export a data lineage diagram to a Microsoft Excel file. You 
can perform other tasks in Metadata Manager while Metadata Manager exports the diagram.

Exporting Metadata Objects
You can export metadata objects to a PDF, HTML, or Excel file. Metadata Manager includes the date and time 
of publication and the name of the object in the export file.

1. Select a metadata object. 

2. In the Details panel, click Actions > Export. 

The Export window appears.

3. Select the file type. 

4. Select the objects and the object properties to include in the export file. 

5. Click Export. 

The options to open or save the file vary based on the browser.

Exporting a Data Lineage Diagram
You can export a data lineage diagram as a SVG image file, as a Microsoft Excel file, or you can print the 
diagram. If you highlight an object in the diagram before you export it to a SVG file, Metadata Manager 
highlights the object in the SVG file.

1. Run data lineage analysis for a metadata object. 

2. Click Actions > Export. 

3. Select one of the following options: 
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• Save diagram to a Microsoft Excel document.

• Save diagram to an image file.

• Print diagram.

4. Click Export. 

If you save the diagram, the options to open or save the file vary based on the browser.

5. If you print the diagram, select a printer, and click OK. 

Viewing Data Lineage in Microsoft Excel
When you export a data lineage diagram to Microsoft Excel, the exported diagram includes all metadata 
objects and connections.

The following table describes the worksheets in the Microsoft Excel file:

Worksheet Name Description

Lineage Information General information about the data lineage diagram.

Structure-Level Information Properties for each structure in the data lineage diagram, organized by resource 
name. A structure is an object in the metadata catalog or business glossary that 
contains fields. For example, a structure can be a PowerCenter source definition 
instance or an Oracle table.

Field-Level Information Properties for fields in the diagram, organized by resource name. A field is a 
subset of a structure. For example, a field can be a PowerCenter transformation 
port or an Oracle table column.

Connections By Structure List of each structure in the diagram. Includes the structures and fields to which 
each structure and its corresponding fields are connected in the diagram. 
Connections are organized by resource name and structure name.

All Connections List of all connections between structures and fields in the diagram.

You can use the exported data lineage diagram to determine the impact of metadata changes on all 
metadata objects in a data lineage flow. For example, multiple reports in a business intelligence tool use a 
table in an Oracle database. A column is added to the table. You want to assess the impact of the column 
change on the metadata objects in the reports that reference the Oracle table. You can trace the effect of the 
metadata change by viewing all metadata objects that reference the Oracle table.

The Microsoft Excel file includes hyperlinks to information in other worksheets in the file. Use the hyperlinks 
to move between worksheets and get details about structure, field properties, and field connections.
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Lineage Information Worksheet
The Lineage Information worksheet contains a section with general properties for a data lineage diagram.

The following table describes the property in the Lineage Analysis section:

Property Description

Run On Date and time you ran the data lineage analysis.

The following table describes the properties in the Seed Element Information section:

Property Description

Object Name Name of the metadata object or business term for which you ran the data lineage analysis. The object 
name is linked to the data lineage diagram that you exported lineage for.

Class Name Class type for the object.

Location Location of the metadata object in the metadata catalog or business glossary.

Resource Name of the resource in the metadata catalog or business glossary that contains the object.

Structure-Level Information Worksheet
The Structure-Level Information worksheet contains properties for the resources and structures in a data 
lineage diagram.

Structures are objects in the metadata catalog or business glossary that contains fields. The structures are 
organized by resource name. The worksheet contains a section for each resource and the structures in that 
resource. The resources and structures appear in the same order that they appear in the metadata catalog or 
business glossary. Use this worksheet to get details about the properties of a structure in a data lineage 
diagram.

The properties for each resource in the worksheet depend on the resource type. For example, Oracle resource 
properties include resource name, resource type, and schema name.

Metadata Manager exports all properties that appear in the Details panel when you view a metadata object. 
The properties depend on the object type. The properties appear below the row that contains the structure.

The following table describes the properties for all structures:

Property Description

Object Name Name of the object in the metadata catalog or business glossary.

Business Name Business name for the object.

Object Class Class of the object.

Location Location of the object in the metadata catalog or business glossary.

Description Description for the object.

Source Creation Date Date the metadata object was created in the metadata source system.
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Property Description

Source Update Date Date the metadata object was modified in the metadata source system.

MM Creation Date Date the object was loaded into the metadata catalog.

MM Update Date Date the object was updated in the metadata catalog.

Endpoint Indicates if the object is an upstream or downstream endpoint in the data lineage diagram. An 
endpoint indicates that the structure does not have any links to other structures or fields 
upstream or downstream from the current structure.

Connections Hyperlink to the list of connections for the object in the Connections By Structure worksheet.

Use the following rules and guidelines when you view the structure-level properties:

• A structure is an upstream endpoint if it meets the following conditions:

- It does not have upstream connections to other structures or fields.

- No field in the structure has an upstream connection to another structure or field outside of the 
structure.

• A structure is a downstream endpoint if it meets the following conditions:

- The structure does not have a downstream connection to another structure or field.

- No field in the structure has a downstream connection to another structure or field outside of the 
structure.

• PowerCenter mappings appear with the following syntax:

<mapping name> : <session name>

Field-Level Information Worksheet
The Field-Level Information worksheet contains properties for the resources and fields in a data lineage 
diagram.

A field is a child object for a metadata object. The fields are organized by resource name to show all fields 
for a resource. The worksheet contains a section for each resource and the fields in that resource for each 
parent object. The resources, parent objects, and fields appear in the same order as the metadata catalog. 
Use this worksheet to get details about an individual field in a data lineage diagram.

The properties for each resource in the worksheet depend on the resource type. For example, Oracle resource 
properties include resource name, resource type, and schema name.

Metadata Manager exports all properties that appear in the Details panel when you view a field. The 
properties depend on the object type. The properties appear below the row that contains the field.

The following table describes the properties for all fields:

Property Description

Parent Object Name Parent object for the field.

Parent Object Class Parent object class for the field.

Field Name Name of the field in the metadata catalog.
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Property Description

Business Name Business name for the field.

Location Location of the field in the metadata catalog.

Expression Expression that defines the value for the field.

Description Description for the field.

Source Creation Date Date the field was created in the metadata source system.

Source Update Date Date the field was modified in the metadata source system.

MM Creation Date Date the field was loaded into the metadata catalog.

MM Update Date Date the field was updated in the metadata catalog.

Endpoint Indicates if the object is an upstream or downstream endpoint in the data lineage diagram. An 
endpoint indicates that the field does not have any links to other structures or fields upstream 
or downstream from the current field.

Connections Hyperlink to the list of connections for the parent object in the Connections By Structure 
worksheet.

In addition, Metadata Manager exports all properties that appear in the Details panel when you view a 
metadata object. The properties depend on the object type. The properties appear below the row that 
contains the field.

Use the following rules and guidelines when you view the field-level properties:

• A field is an upstream endpoint if it does not have any upstream connection.

• A field is a downstream connection if it does not have any downstream connection.

• PowerCenter mappings and mapplets appear with the following syntax:

<mapping name> : <session name>

Connections By Structure Worksheet
The Connections By Structure worksheet contains the source and target connection properties for each 
structure in a data lineage diagram. It includes the structures and fields to which each structure and its 
corresponding fields are connected in the diagram. The worksheet contains a section for each resource and 
a section for each structure in the resource. The connection properties include the source and target field 
connections for each structure. The resources and structures appear in the same order as the metadata 
catalog or business glossary. Use this worksheet to view the connections for each structure in a data lineage 
diagram.

The properties for each resource in the worksheet depend on the resource type. For example, Oracle resource 
properties include resource name, resource type, and schema name. Each structure section contains a 
hyperlink to the structure properties on the Structure-Level Information worksheet.
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The following table describes the properties for each connection in the worksheet:

Property Description

From Resource Resource name that contains the parent object of the source field.

From Structure Name of the parent object for the source field. Contains a hyperlink to the structure 
properties on the Structure-Level Information worksheet.

From Structure Location Location of the parent object in the metadata catalog or business glossary.

From Field Name of the source field. Contains a hyperlink to the field properties on the Field-
Level Information worksheet.

To Resource Resource name that contains the parent object of the target field.

To Structure Name of the parent object for the target field. Contains a hyperlink to the structure 
properties on the Structure-Level Information worksheet.

To Structure Location Location of the parent object in the metadata catalog or business glossary.

To Field Name of the target field. Contains a hyperlink to the field properties on the Field-
Level Information worksheet.

All Connections Worksheet
The All Connections worksheet contains a list of all connections in the data lineage diagram. Use this 
worksheet to sort the connections and view properties for a specific connection.

The following table describes the properties for each connection in the worksheet:

Property Description

From Resource Resource name that contains the parent object of the source field.

From Structure Name of the parent object for the source field. Contains a hyperlink to the structure 
properties on the Structure-Level Information worksheet.

From Structure Location Location of the parent object in the metadata catalog or business glossary.

From Field Name of the source field. Contains a hyperlink to the field properties on the Field-
Level Information worksheet.

To Resource Resource name that contains the parent object of the target field.

To Structure Name of the parent object for the target field. Contains a hyperlink to the structure 
properties on the Structure-Level Information worksheet.

To Structure Location Location of the parent object in the metadata catalog or business glossary.

To Field Name of the target field. Contains a hyperlink to the field properties on the Field-
Level Information worksheet.
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C h a p t e r  8

Business Glossaries
This chapter includes the following topics:

• Business Glossaries Overview, 80

• Category and Business Term Details, 81

• Reference Tables, 82

• Relationships for Business Glossary Objects, 83

Business Glossaries Overview
You can view business glossary resources in Metadata Manager in the Glossary view. A business glossary 
resource contains metadata extracted from an Analyst tool business glossary. You can view the categories 
and business terms in each business glossary resource.

Business glossary metadata objects behave like other metadata objects in Metadata Manager. For example, 
you can run data lineage analysis on business terms. You can also view impact summary and search for 
categories and business terms.

You can perform the following additional tasks with business glossaries:

View information about a category or business term.

You can view properties about a category or business term that are imported from the Analyst tool such 
as name, description, usage context, and owner. You can also display information such as links, 
comments, related catalog objects, and impact summary.

View reference tables.

To view a reference table that is linked to a business term, view the business term, and click the 
reference table URL.

Relate business terms to other catalog objects.

To view the metadata that a business term represents, relate the term to another catalog object.

View a category or business term in the Analyst tool.

To view a category or business term in the Analyst tool, select the object in the navigator and click 
Actions > View in Informatica Analyst or click the View in Informatica Analyst icon on the toolbar.

Note: You must have appropriate privileges on the Metadata Manager Service and permission on the 
business glossary resource to perform these tasks. For more information about Metadata Manager Service 
privileges, see the Informatica Security Guide. For more information about resource permissions, see the 
Metadata Manager Administrator Guide.
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Related Topics:
• “Impact Summary” on page 26

• “Searching Metadata” on page 30

• “Working with Data Lineage” on page 56

Category and Business Term Details
To view information about a category or business term, select the category or business term in the Glossary 
view. Information about the category or business term appears in the Details panel.

The following table describes the information in the Details panel for categories and business terms:

Area Category / 
Business Term

Description

Properties Category
Business Term

General properties for the category or business term that are defined in the 
Analyst tool. Properties for categories include name, status, and phase. 
Properties for business terms include name, description, data steward, owner, 
status, and phase.
The Properties area also includes the following properties:
- Class. Class type, either Category or BusinessTerm.
- MM Creation Date. Date the object was created in Metadata Manager.
- MM Update Date. Date the object was last updated in Metadata Manager.
- Location. Location of the object in Metadata Manager.

Categories Business Term The categories to which a business term belongs.

Related Terms Business Term Business terms related to the current business term.

Reference Table Business Term Links to reference tables that contain valid or default values for a business 
term.

Links Category
Business Term

Links to supporting documentation for the category or business term.

Comments Category
Business Term

Comments made by Metadata Manager users about the category or business 
term. Use comments to share information about the object with other 
Metadata Manager users.

Related Catalog 
Objects

Business Term Metadata objects in the metadata catalog that the business term represents.

Impact Summary 
Downstream

Business Term Metadata objects that are impacted by the objects related to the business 
term. In a data lineage diagram, these objects are downstream from the 
related object. You can filter objects based on resource types.

Impact Summary 
Upstream

Business Term Metadata objects that impact objects related to the business term. In a data 
lineage diagram, these objects are upstream from the related object. If 
required, you can filter objects based on resource types.
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Related Topics:
• “Impact Summary” on page 26

• “Comments” on page 48

• “Links” on page 49

Viewing Category and Business Term Details
View category and business term details in the Glossary view.

1. Select the Glossary view in Metadata Manager. 

2. From the Show list, select a business glossary. 

You can sort the glossary metadata in the following ways:

• To view business terms grouped by category, click Actions > View > Categories.

• To view all business terms in alphabetic order, click Actions > View > Alphabet.

• To view all business terms that start with a specific letter, click the letter.

3. To view details about a category or business term, select the category or business term. 

Metadata Manager displays details about the category or business term in the Details panel.

Reference Tables
In the Analyst tool, you can link a business term with a reference table. You can view the reference table from 
Metadata Manager when you view the business term.

For example, a business analyst creates a report on a data warehouse that contains data migration results. 
The analyst needs to verify that the state value for the customer address contains valid values. The analyst 
creates a reference table that describes the mapping between possible values for the state and the valid 
value. In the Analyst tool, the analyst associates the reference table URL to the business term that defines 
the customer information.

To view the reference table from Metadata Manager, view the business term, and click the reference table 
URL.

Viewing Reference Tables
View reference tables for a business term from the Details panel in the Glossary view.

1. In the Glossary view, select a business glossary. 

2. Select the business term. 

3. In the Details panel, click the link for the reference table under Reference Table. 

Metadata Manager displays the reference table in a browser window.
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Relationships for Business Glossary Objects
To relate a business term to technical metadata, create a relationship between the term and the metadata 
object. Metadata Manager updates the relationship information in the Analyst tool business glossary.

Relate a business term to technical metadata to define the data and the accepted use cases. For example, 
the Customer table in an Oracle resource contains the STATUS column. You are not sure if the STATUS 
column indicates whether the customer is an active customer or whether the customer is a preferred 
customer. Link the STATUS column with the business term "customer status" to define the column data.

The method you use to create a relationship depends on the number of relationships that you want to create:

Single relationship

Use the Details panel to create a relationship between a single business term and metadata object.

Multiple relationships

Use linking rules, enumerated links, or the Objects Relationships Wizard to create multiple relationships 
between business terms and metadata objects.

After you create a relationship between a business term and a metadata object, Metadata Manager performs 
the following actions:

• When you view the business term in the Glossary view, Metadata Manager lists the metadata object in the 
Related Catalog Objects section of the Details panel.

• When you view the metadata object in the metadata catalog, Metadata Manager lists the term in the 
Related Terms section of the Details panel.

• If the metadata object to which you link the term is a lineageable object, Metadata Manager displays a 
lineage link between the object and the business term when you run data lineage analysis on the object.

• Metadata Manager updates the relationship information in the Analyst tool business glossary. For 
example, you create a relationship from the Annual Salary business term to the SALARY column in an 
Oracle resource in Metadata Manager. When you view the Annual Salary business term in the Analyst tool, 
the SALARY column is listed as a related asset.

Single Relationships for Business Terms
Create a single relationship between a business term and a metadata object through the Details panel on the 
Browse tab.

Use either of the following methods to create the relationship:

From the business term to the metadata object

Select a business term in the Glossary view and edit the related catalog objects. Drag the related object 
from the metadata catalog into the dialog box.

From the metadata object to the business term

Select a metadata object in the Catalog view or the Shortcuts view and edit the related terms. Drag the 
related term from the glossary into the dialog box.

When you create a single relationship for a business term, you do not have to reload the resources to see the 
links.
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Multiple Relationships for Business Terms
Create relationships between multiple business terms and metadata objects through linking rules, 
enumerated links, or the Objects Relationship Wizard.

Use any of the following methods to create the relationships:

Rule-based links

Rule-based links define rules that Metadata Manager uses to link matching objects across resources. 
Use rule-based links when you have multiple objects to link and the objects have some attribute or 
property in common. For example, you might create a linking rule that links a business glossary term to 
an Oracle column when the business term "Technical Name" attribute matches the Oracle column name.

To create relationships with rule-based links, you create linking rules files. Linking rules files contain the 
expressions that Metadata Manager uses to link business terms with metadata objects in other 
resources. Upload the linking rules files when you edit the Business Glossary resource. Metadata 
Manager creates the links when you load the resource.

Enumerated links

Enumerated links define data lineage relationships between specific pairs of objects. Use enumerated 
links to create relationships when you have multiple pairs of objects to link and you cannot create a 
linking rule.

To create relationships with enumerated links, you create enumerated links files that associate individual 
business terms with metadata objects in other resources. Enumerated links files are CSV files that 
contain individual pairs of objects that you want to link. Upload the enumerated links files when you 
create or edit the Business Glossary resource. Metadata Manager creates the links when you load the 
resource.

Objects Relationships Wizard

Select a glossary in the Glossary view, and use the Objects Relationships Wizard to create relationships 
for multiple terms. When you create relationships from the Browse tab, you do not have to reload the 
resources to see the links.

For more information about rule-based links or enumerated links, see the Metadata Manager Custom 
Metadata Integration Guide. For more information about creating, editing, and loading business glossary 
resources, see the Metadata Manager Administrator Guide.

Related Topics:
• “Creating and Deleting Multiple Relationships” on page 53

Relationships to PowerCenter Objects
You can create a relationship between a business term and a PowerCenter object.

Some PowerCenter objects can be used in multiple contexts, used in a single context, or can refer to an 
original object.

The information that a data lineage diagram displays depends on the following PowerCenter object types that 
you can associate to a business term:

Reusable transformation or session

A reusable transformation or session can be used in multiple contexts.

When you run data lineage analysis on the business term, the data lineage diagram displays the 
PowerCenter object and all instances of the object. However, when you view the details of the business 
term, the Related Catalog Objects section displays only the reusable PowerCenter object.
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When you run data lineage analysis on any instance of the PowerCenter object, the data lineage diagram 
displays the associated business term. However, when you view the details of an instance of the 
PowerCenter object, the Related Business Terms section does not display the business term.

Note: If the reusable object is not used in another PowerCenter object, the data lineage diagram does not 
display the relationship between the business term and the reusable object.

Instance of a transformation or session

An instance of a transformation or session is used in a single context.

When you run data lineage analysis on the business term, the data lineage diagram displays the 
PowerCenter object instance within the context where the instance is used. For example, you relate a 
business term to a Lookup transformation instance. The data lineage diagram of the business term 
shows the Lookup transformation instance within its corresponding mapping and session context.

Shortcut

A shortcut refers to an original object.

When you run data lineage analysis on the business term, the diagram displays the instances of the 
original object and all instances of the shortcuts to the original object. However, when you view the 
details of the business term, the Related Catalog Objects section displays only the shortcut.

When you reload the PowerCenter resource, Metadata Manager creates or deletes associations based on 
changes made to the source. For example, you create a relationship between a business term and a reusable 
PowerCenter transformation that has one instance in a mapping. In the PowerCenter source, you add another 
instance of the transformation to a mapping. When you reload the PowerCenter resource, Metadata Manager 
associates the additional instance of the transformation to the business term.

Creating Relationships to Metadata Objects
Create relationships from business terms to metadata objects in the Details panel of the Glossary view.

1. From the Show list in the Glossary view, select a business glossary. 

2. Select the business term. 

3. In the Details section, click Edit under Related Catalog Objects. 

The Edit Related Catalog Objects window appears.

4. In the Catalog view, select a metadata object. 

5. Drag the business term into the Edit Related Catalog Objects window. 

6. To remove a relationship, select the metadata object in the Edit Related Catalog Objects window and 
click Remove. 

If a business term is related to a reusable PowerCenter object, you can delete the relationship to the 
reusable object. Metadata Manager removes the associations to all instances of the object. However, 
you cannot delete the relationship for a single instance of the object.

7. Click OK. 

Creating Relationships to Business Terms
Create relationships from metadata objects to business terms in the Catalog view or the Shortcuts view.

1. In the Catalog view or the Shortcuts view, select a metadata object. 

2. In the Details panel, click Edit under Related Terms. 
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The Edit Related Terms window appears.

3. From the Show list in the Glossary view, select the business glossary. 

4. Drag the business term into the Edit Related Terms window. 

5. To remove a relationship, select the business term in the Edit Related Terms window and click Remove. 

6. Click OK. 

Viewing Related Catalog Objects
View related catalog objects in the Details panel of the Glossary view. You can sort and filter the related 
catalog objects by type, name, and path.

1. From the Show list in the Glossary view, select a business glossary. 

2. Select a business term. 

Metadata Manager displays the object details, including the related catalog objects, in the Details panel.

3. To sort the related catalog objects by type, name, or path, click the column heading. 

You can sort objects in ascending or descending alphanumeric order. Click the column heading again to 
change the sort order.

4. To filter the related catalog objects by type, name, or path, enter the filter text in the fields above the 
column headings, and click the Filter button. 

Enter the first several characters of the phrase that you want to use for filtering. You cannot use wildcard 
characters in the filter text. For example, to display only objects in resource "FinanceDB" enter "MM/
FinanceDB" in the Path filter field.

To remove the filters, clear the filter fields and click the Filter button.

5. To view a related catalog object in the metadata catalog, click the link for the object name. 

Metadata Manager switches to the Catalog view and displays the details about the metadata object.
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C h a p t e r  9

Using the URL API
This chapter includes the following topics:

• Using the URL API Overview, 87

• URL API Syntax with Menus and Tabs, 88

• URL API Syntax without Menus and Tabs, 89

Using the URL API Overview
You can provide access to Metadata Manager objects from third-party applications through the URL API. Use 
the URL API to view Metadata Manager objects from another application. For example, you can view a data 
lineage diagram for a particular catalog object from a business intelligence tool.

Use the URL API to provide access to the following types of objects:

• Business glossary objects

• Catalog objects

• Shortcuts

• Data lineage diagram for a catalog or glossary object

• Results from a basic search

• Browse, Model, Load, and Security tabs

Metadata Manager represents each object with a URL. When you view an object in Metadata Manager, the 
URL appears in the URL address bar. You can copy the URL and paste it into another application to access 
the object again.

When you click the URL in the other application, Metadata Manager displays the results in a browser window. 
You must log in to Metadata Manager before you can view the results.

You can display objects in third-party applications with or without the Metadata Manager menus and tabs. 
When you display objects with the menus and tabs, users of the third-party application can perform all tasks 
in Metadata Manager that they have permission to perform. When you display objects without the menus and 
tabs, users of the third-party application cannot view other objects or perform other tasks in Metadata 
Manager.

The URL API actions depend on the number of objects found:

No object found

If Metadata Manager cannot find the object, it displays an error message in the browser window. Verify 
the URL API syntax and that the metadata object exists in the Metadata Manager warehouse.
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One object found

Metadata Manager displays the results.

More than one object found

If Metadata Manager finds more than one business glossary, catalog, or shortcut object, it displays the 
first object it encounters. If Metadata Manager finds multiple objects when trying to show data lineage 
on an object, it displays an error message.

URL API Syntax with Menus and Tabs
To use the URL API, create a link to the object that you want to view from the third-party application. When 
you click the link, Metadata Manager displays the object details in a browser window. You can include the 
Metadata Manager menus and tabs in the browser window.

To display metadata objects in a third party application with the Metadata Manager menus and tabs, use the 
following syntax:

http[s]://<host name>:<port>/mm/#<page type>___<resource name>%252<object location>
%252<object name>

Arguments are case sensitive.

The following table describes the URL API arguments:

Argument Description

host name Required. Host name of the machine running the Metadata Manager application.

port number Required. Port number of the Metadata Manager application.

page type Required. Type of page. Valid values are browse, model, load, and security.

resource name Required if you create a URL for a catalog object. Name of the resource in the catalog.

object location Required if you create a URL for an object in a business glossary or catalog. Location of the object in 
the business glossary or catalog.
The value of this argument must meet the following requirements:
- For a catalog object, start with the top-level resource name, such as PowerCenter or Oracle_DB.
- End with the name of the object you want to use.
- Use the slash character (/) as the delimiter.

object name Required if you create a URL for an object in a business glossary or catalog. Name of the metadata 
object in the business glossary or catalog.

The URL must also conform to the following rules:

• Parameters must be separated by three underscore characters.

• Metadata Manager uses the URL-encoded form %2F instead of the slash character (/) as the delimiter.

• Metadata Manager uses URL-encode form %20 for a space, instead of whitespace.
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The following table shows examples of URLs:

Object Type Example

Browse Catalog page http://<localhost>:<port number>/mm/#browse___catalog

Browse Glossary page http://<localhost>:<port number>/mm/#browse___glossary

Browse Shortcut page http://<localhost>:<port number>/mm/#browse___shortcuts

Model page http://<localhost>:<port number>/mm/#model

Load page http://<localhost>:<port number>/mm/#load

Permissions page http://<localhost>:<port number>/mm/#security

Business glossary object http://<localhost>:<port number>/mm/#browse___glossary___MM
%252FBusiness_Glossary%252FCosts%252FCost%2520Ratio

Catalog object http://<localhost>:<port number>/mm/#browse___catalog___MM
%252FPowerCenter%252FMM_Financial_dm%252FMappings
%252Fm_Fin_Fact_Table_xml

Shortcut http://<localhost>:<port number>/mm/#browse___shortcuts___
%252FAdministrator%2520%255BNative%255D%252FChange%2520Requests
%252FOVERHEAD

Data lineage http://<localhost>:<port number>/mm/#browse___lineage___MM
%252FOracle%252FBAE%252FTables%252FTRANSACTIONS%252FColumns
%252FOVERHEAD

Results from a basic search http://<localhost>:<port number>/mm/
#browse___search___all___Transaction

URL API Syntax without Menus and Tabs
To use the URL API, create a link to the object that you want to view from the third-party application. When 
you click the link, Metadata Manager displays the object details in a browser window. You can exclude the 
Metadata Manager menus and tabs from the browser window.

To display metadata objects in a third party application without the Metadata Manager menus and tabs, use 
the following syntax:

http[s]://<host name>:<port>/mm/lineage?objectPath=MM/<resource name>/
<metadata object path>/<metadata object name>&mode=<mode>

Arguments are case sensitive.

For example, to view the Address business term in the Customers category of the Sales business glossary, 
use the following URL:

http://MMHost:10250/mm/lineage?objectPath=MM/Sales/Customers/Address&mode=detail
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The following table describes the lineage URL API arguments:

Argument Description

host name Required. Host name of the machine that runs the Metadata Manager application.

port Required. Port number of the Metadata Manager application.

resource name Required. Name of the resource in the metadata catalog or name of the business glossary.

metadata object 
path

Required. Path to the metadata object in the metadata catalog.
The value of this argument must meet the following requirements:
- Start with the top-level resource name, such as PowerCenter or Oracle_DB.
- End with the name of the object that you want to use.
- Use the same delimiter for the entire path. Use the slash character (/).

metadata object 
name

Required. Name of the metadata object in the metadata catalog or the name of the category or 
business term in a business glossary.

mode Optional. Display mode for the metadata object, category, or business term:
- lineage. Displays the data lineage diagram and the information in the Details panel.
- detail. Displays the information in the Details panel only.
Default is lineage.
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A p p e n d i x  A

Configure the Web Browser
This appendix includes the following topic:

• Configure the Web Browser, 91

Configure the Web Browser
You can launch Metadata Manager through Microsoft Internet Explorer or through Google Chrome. To use 
Metadata Manager, you might need to configure different options in the browser.

You might need to configure the following options:

Scripting and ActiveX

Enable the following controls on Microsoft Internet Explorer:

• Active scripting

• Allow programmatic clipboard access

• Run ActiveX controls and plug-ins

• Script ActiveX controls marked safe for scripting

To configure the controls, click Tools > Internet options > Security > Custom level.

Pop-up blocking utility

To display pages in the web client, disable any pop-up blocking utility on your browser.

Trusted sites

If the Informatica domain runs on a network with Kerberos authentication, you must configure the 
browser to allow access to the Informatica web applications. In Microsoft Internet Explorer, Microsoft 
Edge, and Google Chrome, add the URL of the Informatica web application to the list of trusted sites. In 
Safari, add the certificate of the Informatica web application to the keychain. If you are using Chrome 
version 86.0.42x or later on Windows, you must also set the AuthServerWhitelist and 
AuthNegotiateDelegateWhitelist policies.

Browser cache

On Internet Explorer, to ensure that Metadata Manager properly caches pages and applies user 
privileges, set the browser cache options. Click Tools > Internet Options. Under Browsing history, click 
Settings. Under Check for newer versions of stored pages, select Every time I visit the webpage.
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A p p e n d i x  B

Glossary
attribute

Characteristic of a metadata object. An attribute is a property defined for a class that applies to all metadata 
objects of the class. For example, in a PowerCenter repository, the Session class contains attributes such as 
description, last run time, and creation date. An object property is a characteristic about a specific metadata 
object.

business glossary

Set of business term definitions. Each term can correspond to metadata objects in the metadata catalog.

business name

Property used to identify a metadata object according to the object's business usage. All classes in 
packaged, universal, and custom models have a business name. You can edit the business name property in 
Metadata Manager. You cannot edit any other properties of packaged or universal model classes.

business term

Metadata object that represents the business usage of metadata in the metadata catalog. A business term 
can include a description, a data steward, an owner, a rule that defines how the object is derived, a status, the 
business usage context, and a link to a reference table.

category

A group of related business terms. A business term can be part of zero or more categories. You can create 
nested categories. Grouping business terms in categories is optional.

class

Type of object a source repository can contain. Each class contains a set of attributes that describe the 
characteristics of objects of the class. Each class can have zero or more relationships to other classes. 
Related classes can be within the same model or in a different model. Each class has one related parent 
class in the same model. Each class can have zero or more related child classes in the same model.

connection assignment

Part of a resource configuration that specifies how linkable objects in a packaged or universal resource can 
be related to matching objects in another packaged or universal resource. Metadata Manager can create 
links to corresponding objects in the resources on either side of the connection assignment. These cross-
resource links allow to you run data lineage analysis across metadata sources.



custom resource template

Contains the mapping rules between source custom metadata and the target model classes for a custom 
resource. The rules define how to create the custom objects and define the relationships between custom 
metadata objects and objects in other resources.

data lineage diagram

Diagram representing the conceptual flow of data from sources to targets. Data lineage analysis includes all 
possible paths for the data flow, and it may span multiple resources of different resource types. In data 
lineage analysis, boxes or nodes represent objects. Arrows represent flow relationships.

data steward

User or group in an organization who is responsible for the definition of a business term.

data structure

Object that contains fields with data. Examples of data structures include a PowerCenter source instance, 
PowerCenter target instance, PowerCenter source qualifier, database table, and database view. See also 
field.

deprecated resource

A resource that was valid in a previous version of Metadata Manager, but is not valid in the current version 
because the model has changed. You can delete, index, purge metadata for, and view configuration 
properties for a deprecated resource. You cannot create, configure, edit, load, or add schedules for a 
deprecated resource. To create, configure, edit, load, or add schedules for a deprecated resource, you must 
migrate the resource to the current version of Metadata Manager.

endpoint

Object in a metadata source that has a connection to another object in an external metadata source. 
Business Intelligence, Data Integration, and Data Modeling resource types contain endpoints.

field

Subset of a data structure that represents a single data item. Examples of fields include database table 
columns and view columns, PowerCenter transformation instance ports, and business intelligence report 
metrics and attributes.

link

Hyperlink to a document or web page. Any Metadata Manager object can have links. Use links to extend the 
information available about a metadata object, category, or business term.

A link can also be a relationship between objects from different resources. To run data lineage analysis 
across resources, assign connections from one resource to another or configure linking rules for the 
resources. Then, instruct Metadata Manager to create links between matching objects using the connection 
assignments or using the linking rules.

linking rule

Expression that Metadata Manager uses to create link relationships between matching objects across 
different resources. A linking rule defines the set of possible objects in a source resource, the set of possible 
objects in a target resource, and an expression that defines which source and target objects match. Matching 
objects should be linked.
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linking rule set

A group of rules that links objects between two resources.

linking rules file

An XML file that contains linking rules, linking rule definitions, or linking rules parameters. Rule set files, rule 
set definition files, and rule set parameter files are all types of linking rules files.

logical group

Group of metadata objects of the same class and with the same parent object. Metadata Manager groups 
metadata objects into logical groups in the metadata catalog.

metadata catalog

Hierarchical view of the metadata in the Metadata Manager warehouse.

Metadata Exchange

Process that defines how to extract metadata from metadata sources and load the metadata into the 
Metadata Manager warehouse. Metadata Manager packages Metadata Exchanges for each of the supported 
metadata source types.

Metadata Manager Agent

Windows executable program or service that Metadata Manager uses to access metadata sources and 
extract source metadata for data modeling, business intelligence, and JDBC source types.

The Metadata Manager Agent must run on the same machine as the client of the metadata source. Based on 
the metadata source client location, you can use the Metadata Manager Agent located on the Metadata 
Manager application machine, or you can install the agent on another machine. During Metadata Exchange, a 
remote Metadata Manager Agent uses the TCP/IP network protocol to communicate with the Metadata 
Manager application.

Metadata Manager application

Web-based application that manages the metadata in the Metadata Manager warehouse. In Informatica 
Administrator, create a Metadata Manager Service to access the Metadata Manager application.

Metadata Manager repository

Contains the Metadata Manager warehouse and models. Metadata Manager uses models to define the 
classes and relationships that represent the metadata in metadata sources. The models include packaged 
models, optional universal models, and optional custom models. The Metadata Manager repository is stored 
as a set of tables and views in a relational database.

Metadata Manager Service

An application service that runs the Metadata Manager application in an Informatica domain. It manages 
access to metadata in the Metadata Manager warehouse.

Metadata Manager warehouse

Central warehouse repository that stores metadata from different metadata sources.
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metadata source type

Source type from which Metadata Manager can extract metadata. Metadata Manager packages a model and 
a Metadata Exchange for each source type. Examples of metadata source types include Business Objects, 
PowerCenter, and Oracle databases. Each metadata source has one of the following source domains: 
application, business intelligence, data integration, data modeling, or relational.

model

Group of classes, relationships, and attributes that define the metadata that Metadata Manager can extract 
from a metadata source. Metadata Manager packages models for supported metadata sources. In addition 
to the packaged models, you can create universal models to define metadata sources for some business 
intelligence, data integration, data modeling, and database management metadata sources for which 
Metadata Manager does not package a model. You can also create custom models to define custom 
metadata.

object

Metadata element from a source repository. An instance of a class. Examples of objects include a 
PowerCenter mapping, a business intelligence report, or a database column.

Object Relationships Wizard

Creates associations between matching objects in a custom resource and objects in another resource. You 
define the classes and attributes to match.

owner (of a business term)

User or group in an organization who owns the definition of data and metadata.

permission

The level of access a user has to a metadata object. Even if a user has the privilege to perform certain 
actions, the user may also require permission to perform the action on a particular object. You define object 
permissions in Metadata Manager. An object can inherit permissions from the containing folder or resource.

PowerCenter Integration Service

A PowerCenter application service that runs the Metadata Exchange processes. The processes are data 
integration workflows that load source metadata into the Metadata Manager warehouse. The workflows are 
stored in the PowerCenter repository associated with the PowerCenter Integration Service. When you create a 
Metadata Manager Service, you configure the associated PowerCenter Integration Service.

PowerCenter repository

Contains the PowerCenter definitions of the Metadata Exchanges, including sources, targets, sessions, and 
workflows. The associated PowerCenter Integration Service uses the definitions to load source metadata into 
the Metadata Manager warehouse.

PowerCenter Repository Service

An application service in an Informatica domain that manages the PowerCenter repository. The PowerCenter 
repository contains the metadata objects for the Metadata Exchange processes used by Metadata Manager.

privilege

Determines the actions that users can perform in Metadata Manager. Use Informatica Administrator to 
assign privileges to users and groups for the Metadata Manager Service. See also permission on page 95.
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relationship

Association between two classes or two specific metadata objects.

repository folder

Metadata object that contains other metadata objects. Folders appear under a resource or under another 
folder in the metadata catalog.

resource

Object that represents a source repository in Metadata Manager. Each resource configuration contains 
properties required to connect to the source repository, extract metadata from the source repository, and 
load the extracted metadata into the resource. A resource configuration also contains the connection 
assignments used to link objects in the resource to objects in other resources.

resource load

Process of extracting metadata from a metadata source system or source file and writing the metadata to 
the Metadata Manager warehouse. A resource load can include linking and indexing tasks. You can schedule 
a resource load to run at predefined intervals.

rule-based links

Links that Metadata Manager creates between matching objects across metadata sources based on rules 
that you configure to link the resources. You can configure rule-based links between a custom resource and 
another custom, packaged, universal, or business glossary resource. You can also configure rule-based links 
between a business glossary resource and a packaged or universal resource.

rule set definition file

An XML file that defines a linking rule set for a pair of models. A rule set definition file takes at least one rule 
set parameter file. The parameter file specifies the pair of resources to which to apply the rule set.

rule set file

An XML file that defines a linking rule set for a pair of resources.

rule set parameter file

An XML file that specifies the resources to which to apply a rule set definition. The parameter file also 
contains parameter values for resource-specific attributes such as connection names and table names.

shortcut

Pointer to a metadata object in the metadata catalog. You can create and organize shortcuts to commonly 
accessed objects in Metadata Manager.

source repository

Contains metadata objects that Metadata Manager extracts and loads into the Metadata Manager 
warehouse. Examples of source repositories include PowerCenter repositories, Business Objects 
repositories, and Oracle databases. See also metadata source type on page 95.

task

An object that moves data from one data structure to another. Examples of tasks include PowerCenter 
session instances and database views.
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template

See custom resource template on page 93.

transformation

Object that determines how data flows between data structures. Transformations can be reusable or non-
reusable. An example of a reusable transformation is a PowerCenter mapping. An example of a non-reusable 
transformation is a database view.

XConnect

The code and artifacts that Metadata Manager uses to extract metadata from a metadata source. The 
XConnect includes a model that represents the metadata source. Metadata Manager packages an XConnect 
and model for many types of application, business glossary, business intelligence, data integration, data 
modeling, and database management sources. You can create custom or universal XConnects to extract 
metadata from other metadata source types.
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